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ในการผลิตช้ินงานดวยกรรมวิธีการตัดโลหะ (machining) ถาระนาบอางอิงในการผลิต 

(manufacturing datums) หรือในการตรวจสอบขนาดช้ินงาน (inspection datums) มีความแตกตาง
ไปจากระนาบอางอิงสําหรับการบอกขนาดแลว ปญหาท่ีจะเกิดขึ้นตามมาก็คือ ความคลาดเคล่ือน
สะสม (tolerance stacks) ซึ่งสงผลใหผูวางแผนกระบวนการผลิตจําเปนจะตองเปล่ียนแปลงคาความ
คลาดเคล่ือนของมิติในการผลิตหรือในการวัดขนาด เพื่อคงไวซึ่งความตองการใชงานของ
ชิ้นงาน (functional requirement) ที่ผูออกแบบไดกําหนดไว ปญหาเชนนี้จัดเปนปญหาของการแบง
หรือกระจายคาความคลาดเคล่ือน (tolerance allocation problems) ซึ่งมักจะเกิดขึ้นอยูเสมอในการ
วางแผนการผลิต การผลิต และการตรวจสอบขนาด และเปนปญหาที่ตองอาศัยประสบการณและ
ความชํานาญของผูวางแผนกระบวนการผลิต ผูออกแบบเกจตรวจสอบ (gage designer) หรือ 
วิศวกรควบคุมคุณภาพ  

งานวิจัยนี้มีวัตถุประสงคเพื่อพัฒนาโปรแกรมคอมพิวเตอรเพื่อใชสําหรับการแบงคาความ
คลาดเคล่ือนใหเหมาะสมกับมิติชุดใหมเม่ือจุดอางอิงของการผลิตและการตรวจสอบแตกตางไป
จากจุดอางอิงของการบอกขนาด โดยประยุกตเทคนิคของกราฟตนไม (rooted-tree graph) เพื่อสราง
ความสัมพันธระหวางมิติและเทคนิคการหาคาท่ีเหมาะสมท่ีสุดดวยโปรแกรมเชิงเสนตรง (linear 
programming) เพื่อใหไดผลลัพธความคลาดเคล่ือนสําหรับมิติชุดใหมทั้งหมดมีคามากท่ีสุดภายใต
เงื่อนไขความสัมพันธของมิติใชงานและขณะเดียวกันตองอยูในเกณฑที่สามารถผลิตไดในทาง
ปฏิบัติดวยกระบวนการผลิตโดยท่ัว ๆ ไป (processing conditions) 
 โปรแกรมที่พัฒนาข้ึนสามารถหาผลลัพธที่เหมาะสมท่ีสุดใหกับปญหาการแบงคาความ
คลาดเคล่ือนไดคร้ังละหลาย ๆ ชุดคําตอบ โดยไมตองสรางสมการเชิงเสนตรงดวยมือและปอนคา
ใหกับโปรแกรมใหมทุกครั้งเม่ือมีการปรับเปลี่ยนเกณฑความคลาดเคล่ือน ชวยทําใหลดขั้นตอน
และเวลาในการทํางานลงไดมาก โดยที่ผูใชโปรแกรมไมจําเปนตองมีความรูและความชํานาญ
ในทางปฏิบัติมากนัก ก็สามารถกระจายความคลาดเคล่ือนใหกับมิติในการผลิตหรือในการวัดขนาด
ใหม เพื่อคงไวซึ่งความตองการใชงานของช้ินงานที่ผูออกแบบกําหนดไว  
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TOLERANCE ALLOCATION/OPTIMIZATION/LINEAR PROGRAMMING 

 

The problems of tolerance allocation are normally encountered in various 

phases of engineering production ranging from product design, process planning, 

production, to product quality control. To solve such problems requires not only high 

practical experience but also time and efforts. A proper tolerance analysis computer 

package is therefore in need of those personnel involving in aforementioned activities. 

This thesis reports the development of a computerized tolerance allocation 

system, namely, Tolerance Optimization Program (TOLOP). The program is capable 

of optimally allocating blueprint tolerances to a new set of dimensions corresponding 

to the datum for manufacturing. By making use of a rooted-tree graph, all tolerance 

relationship among functional dimensions on a machined part, before and after the 

baseline for dimensioning has been modified, can be created. These relationships and 

other practical machining limitations are taken as the constraints for allocating of 

tolerances with a linear programming algorithm. 

 The Visual Basic language has been used for developing TOLOP for its 

abundant tools for a program development. The inputs required by the package 

include: the number of dimensions involved in a problem, the basic sizes and the 

tolerances together with the end-faces of all old and new sets of dimensions. TOLOP 
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also requires to know a range of the International Tolerance (IT) numbers for the 

machining operation making each dimension. This piece of information enables the 

program to give a solution within a practical feasibility. Futhermore, it requires to be 

entered the number of cycles to execute the routines to obtain the best solution, or a 

set of possible solutions. TOLOP then constructs a rooted-tree for those dimensions 

resulting from the change of datum for dimensioning. This graph records all 

functional dimensions relating to the blueprint dimensions. 

 Starting form a set of the minimum IT numbers for the new set of dimensions, 

TOLOP creates an objective function and a set of linear programming constraints, and 

solves for an optimum solution. It will repeat the routine with different IT numbers 

the number of times specified by the number of executions entered. The user can 

interact with the application to modify the method of applying the IT numbers and the 

number of program runs. 

 TOLOP has been validated by comparing the results from its executions with 

those obtained from two commercial packages Excel and Lindo, and they all agree. 

With 10 linear dimensions and 2 tolerance grades attaching to each dimension, 

TOLOP can give an optimum solution within 10 seconds. It can handle more 

dimensions and tolerance grades at an expense of computing time. 
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บทที่ 1 
บทนํา 

 

1.1 ความเปนมาและความสําคัญของปญหา 
การผลิตช้ินงานดวยกรรมวิธีการตัดโลหะ (machining) ถาหากระนาบอางอิงในการผลิต 

(manufacturing datums) หรือในการตรวจสอบขนาดช้ินงาน (inspection datums) แตกตางไปจาก
ระนาบอางอิงในการบอกขนาดแลว ผลที่จะเกิดขึ้นก็คือปญหาความคลาดเคล่ือนสะสม (tolerance 
stacks) ซึ่ งผู ว างแผนกระบวนการผลิตจํ า เปนตองกระจายค าความคลาดเค ล่ือนใหกับ
มิติ (dimensions) ในการผลิตหรือในการวัดขนาดใหมเพื่อคงไวซึ่งความตองการใชงานของ
ชิ้นงาน (functional requirement) ที่ผูออกแบบกําหนด เราเรียกปญหานี้วา การกระจายหรือแบงคา
ความคลาดเคล่ือน (tolerance allocation) และถึงแมวาในปจจุบันเคร่ืองมือกลที่ใชในการผลิตมี
ความเท่ียงตรงสูงก็ตาม การกระจายคาความคลาดเคล่ือนยังคงเปนเรื่องจําเปนทั้งในดานการ
ออกแบบ การวางแผนการผลิต การผลิต การตรวจสอบ และการประกอบชิ้นงาน ทั้งน้ีเพราะงานตัด
โลหะชนิดหนึ่งสามารถทําไดบนเคร่ืองมือกลที่แตกตางกัน และการตรวจสอบมิติเดียวกันก็สามารถ
ทําไดหลายวิธี นอกจากน้ียังมีชิ้นงานจํานวนมากท่ีตองเปล่ียนตําแหนงการจับช้ินงานหลายคร้ังกวา
การผลิตชิ้นงานจะเสร็จสมบูรณ เพราะฉะน้ันการวิเคราะหความคลาดเคล่ือน (tolerance analysis)
ชนิดน้ีจึงยังคงมีความสําคัญตออุตสาหกรรมการตัดโลหะ โดยเฉพาะอยางยิ่งชิ้นงานท่ีมีหลายมิติ
และมีขั้นตอนในการข้ึนรูปท่ีซับซอน ดังตัวอยางชิ้นงานในรูปที่ 1.1 ซึ่งเปนแบบของชิ้นงานท่ีใช
จริงในอุตสาหกรรม จะเห็นไดวาถาหากระนาบอางอิงของการผลิตเปล่ียนแปลง การกระจายคา
ความคลาดเคล่ือนใหกับมิติของช้ินงานเพื่อการผลิตจะตองใชระยะเวลานานในการพิจารณา
เนื่องจากชิ้นงานมีรูปรางที่ซับซอนและมีงานตัดโลหะหลายชนิดท่ีเกี่ยวของ 
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รูปที่ 1.1 แบบชิ้นงานที่ใชผลิตจริงในอุตสาหกรรม 
 

การกระจายหรือแบงคาความคลาดเคล่ือนใหกับมิติในการผลิตใหมนั้นมีหลักเกณฑวา คา
ความคลาดเคล่ือนมากผลิตไดงายแตไมรับประกันวาชิ้นงานจะใชไดหรือไม คาความคลาดเคล่ือน
นอยผลิตไดยากและตนทุนสูงแตชิ้นงานท่ีผลิตไดสามารถทําหนาท่ีไดเสมอ ดังน้ันการกระจายหรือ
แบงคาความคลาดเคล่ือนจึงตองพยายามใหมิติที่ เกี่ยวของกับความตองการใชงานมีความ
คลาดเคลื่อนมากที่สุด ขณะเดียวกันก็ตองไมทําใหหนาที่ในการใชงานมีความบกพรอง  

หนาท่ีใชงาน (functional requirement) ของชิ้นงานแตละชิ้นเปนสภาวะท่ีชิ้นงานท่ีพิจารณา
สัมพันธกับสวนประกอบอื่น ๆ ของชุดงานประกอบ (assembly) สภาวะเชนนี้จะถูกถายทอดใหกับ
ชิ้นงานประกอบแตละช้ินดวยการกําหนดคาความคลาดเคล่ือนใหกับมิติของช้ินงานท่ีเก่ียวของ ซึ่ง
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เราเรียกมิติที่สัมพันธกับความตองการใชงานของชุดงานประกอบวา  มิติใชงาน  (function 
dimension) ในการผลิตช้ินงานแตละช้ิน มิติใชงานของช้ินงานแตละช้ินก็ คือ ความตองการใชงาน
หรือเปาหมายในการผลิตของช้ินงานนั้น ๆ เพราะถาหากไมสามารถบรรลุเปาหมายนี้ไดก็จะมี
ผลเสียตอหนาที่ใชงานของชุดงานประกอบโดยรวม 

ในปจจุบันมีวิธีการสรางความสัมพันธของความคลาดเคล่ือนในมิติใชงานของชิ้น
สวนประกอบกับความตองการใชงานของชุดงานประกอบอยูหลายวิธี วิธีการเหลาน้ีเปนพื้นฐาน
ของการกระจายความคลาดเคล่ือนในชิ้นงานชิ้นใดช้ินหนึ่งดวย  
 

1.2 การเขียนแผนภาพวงรอบ 
แผนภาพวงรอบ (loop diagram) คือ แผนภาพท่ีแสดงความสัมพันธของความตองการใช

งานของชุดงานประกอบกับมิติใชงานในช้ินสวนประกอบแตละช้ิน การเขียนแผนภาพชนิดนี้เปน
เทคนิคของการออกแบบชุดงานประกอบซ่ึงเปนที่นิยมใชมาเปนเวลานานในอุตสาหกรรม และใน
งานวิจัยทางดานความคลาดเคล่ือน เพราะพบในบทความและหนังสือทางวิชาการมาไมนอยกวา 50 
ป และ C.A. Gladman ไดบันทึกไวอยางเปนระบบในหนังสือเม่ือป 1972 นอกจาก Gladman แลว 
P.Drake และ J.Ligget ก็มีการใชแผนภาพในลักษณะเดียวกันน้ีดวย ถึงแมวาแผนภาพจะมีลักษณะ
เดียวกันแตรายละเอียดของการกําหนดมิติที่ เ ก่ียวของหรือเรียกวา  “มิติใชงาน” (functional 
dimensions) มีความแตกตางกันโดยเฉพาะอยางย่ิง Gladman ไมไดกลาวถึงข้ันตอนหรือวิธีการ
เหลานี้ไวเลย จึงนาจะเขาใจไดวาการกําหนดมิติใชงานนาที่จะตองอาศัยประสบการณในการทํางาน
ทางปฏิบัติดวย ซึ่งความเขาใจเชนนี้ไดรับการยืนยันดวยความแตกตางของวิธีการของ Drake และ 
Ligget ในท่ีนี้จะกลาวถึงวิธีการท้ัง 2 นี้กอนแลวจึงขยายความวิธีการของ Gladman ในภายหลัง 
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 1.2.1 วิธีการของ Drake 
 

75?0
75?0 1.215?0
04?0

5.019?0
8.5?0

5?0
30?0

62.494?0

2.5?0
8.5?0
11.5?

 
 

รูปที่ 1.2 ชิ้นสวนประกอบของมอเตอร (นิ้ว) 
 

พิจารณารูปที่ 1.2 กําหนดให GAP คือ ความตองการใชงานที่ตองมีคามากกวาหรือเทากับ
ศูนย โดย Drake ไดสรุปขั้นตอนการเขียนแผนภาพวงรอบไวดังนี้  
 1) กําหนดใหผิวดานซายของ GAP เปนจุดเร่ิมตนและกําหนดใหผิวดานขวาของ GAP เปน 
  จุดส้ินสุด 
 2) ใชเวคเตอรสรางแผนภาพวงรอบแบบปด จากจุดเร่ิมตนจนถึงจุดส้ินสุด โดยไมรวม  
  GAP (รูปที่ 1.3) 
 3) ใชหัวลูกศรแสดงทิศทางของแตละเวคเตอร โดยระบุเวคเตอรดวยเคร่ืองหมายบวก (+)  
  เม่ือลูกศรช้ีจากซายไปขวา หรือ ระบุเวคเตอรดวยเคร่ืองหมายลบ (-) เม่ือลูกศรช้ีจากขวา 
  ไปซาย 

4) ในรูปเดียวกันน้ีกําหนดชื่อตัวแปรใหแตละมิติและเปล่ียนวิธีการบอกขนาดความ 
 คลาดเคลื่อนใหเปนแบบเบ่ียงเบนจากขนาดมูลฐานเทา ๆ กันท้ังสองขาง 
 (bilateral tolerances) โดยมีตัวอักษรแทนมิติตาง ๆ ดังนี้ X ± x คือ ขอบเขตของ 
 ขนาด GAP ที่ตองการทราบคา; A คือ ขนาดของปลายสกรูถึงผิวลางของหัวสลัก 
 เกลียว หรือ คือ ความยาวของสลักเกลียว; B คือ ความหนาของแหวนรอง (washer);  
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 C คือ ความหนาของแหวนกดแบร่ิง (inner ring bearing cap); D คือ ความหนาของแบริ่ง 
 ตัวแรก (bearing 1); E คือ ความหนาของ spacer; F คือ ความยาวของ rotor; G คือ ความ 
 หนาของ spacer; H คือ ความหนาของแบร่ิงตัวท่ี 2 (bearing 2); I คือ ความยาวของ 
 ปลอกพูลเลย (pulley hub); J คือ ความยาวของเพลา (shaft); K คือ ระยะจากผิวปลาย 
 เพลาถึงกนรู (hole bottom) 

 

  
รูปที่ 1.3 แผนภาพวงรอบสําหรับหาขนาดมูลฐานและความคลาดเคลื่อนของมิติ GAP 

 
5) สรางสมการวงรอบขนาดมูลฐานและสมการวงรอบสําหรับความคลาดเคล่ือนไดดังนี้ 

สมการวงรอบขนาดมูลฐาน : 
X = -A+B+C+D+E+F+G+H+I-J+K                 (1.1) 

         =-0.3595+0.0320+0.0600+0.4305+0.1200+1.5030+0.1200+0.4305+0.4500 
                 -3.0250+0.4000 

X = 0.1615 
สมการวงรอบสําหรับความคลาดเคล่ือน : 

± x = ± (a+b+c+d+e+f+g+h+i+j+k)                 (1.2) 
        = 0.0155+0.0020+0.0030+0.0075+0.0050+0.0070+0.0050+0.0075 
           +0.0070+0.0060+0.0300 
± x = ± 0.0955 

∴ GAP หรือ X ± x = 0.1615 ± 0.0955 
 



 

 

 

 

 

 

 

 

 

6 

เปนที่นาสังเกตวา  ขั้นตอนท่ี  Drake เสนอจะเนนเรื่องของทิศทางการพิจารณาจาก 
functional requirement และไมมีกฎเกณฑอยางอ่ืนกํากับ ซึ่งมีโอกาสท่ีจะเกิดมิติของช้ินงาน
เดียวกันซํ้าซอนในสมการวงรอบได 
 1.2.2 วิธีการของ Ligget 

 

 
 

รูปที่ 1.4 ชิ้นสวนประกอบของดิสเบรก 
 

พิจารณารูปที่ 1.4 กําหนดใหมิติ A ถึง F คือมิติในช้ินสวนท่ีเปนองคประกอบของดิสเบรก
และ G คือ ความตองการใชงานที่ตองการทราบคา โดย Ligget มีขั้นตอนการหาสมการวงรอบดังนี้  

1) กําหนดใหผิวดานขวาของ G เปนจุดเร่ิมตนและใหผิวดานซายของ G เปนจุดส้ินสุด 
2) ใชเวคเตอรสรางแผนภาพวงรอบแบบปด จากจุดเร่ิมตนจนถึงจุดส้ินสุด โดยไมรวม 

ชองวาง G 
3) ใชหัวลูกศรแสดงทิศทางของแตละเวคเตอร โดยระบุเวคเตอรดวยเคร่ืองหมายบวก (+)  

เม่ือลูกศรช้ีจากขวาไปซาย หรือ ระบุเวคเตอรดวยเคร่ืองหมายบวกลบ (-) เม่ือลูกศรช้ี 
จากซายไปขวา 

4) กําหนดชื่อตัวแปรใหแตละมิติและเปล่ียนขนาดมูลฐานและความคลาดเคล่ือนใหเทากัน 
ทั้ง 2 ดาน (bilateral tolerances) ดังรูปที่ 1.5  

 



 

 

 

 

 

 

 

 

 

7 

 
 

รูปที่ 1.5 แผนภาพวงรอบสําหรับหาขนาดมูลฐานและความคลาดเคลื่อนของมิติ G 
 

5) คํานวณหาขนาดมูลฐานโดยใชวิธีทางพีชคณิตคํานวณตามเคร่ืองหมายที่แสดงทิศทาง 
ของแตละมิติไดดังนี้ 
สมการวงรอบขนาดมูลฐาน : 

  X = -A-B-C-D-E+F                   (1.3) 
      = -14.2-30-17.8-48-13.5+125 
  X = 1.5 

6) คํานวณคาความคลาดเคล่ือนโดยการนําความคลาดเคล่ือนทั้งหมดมารวมกันจะได 
สมการวงรอบสําหรับความคลาดเคล่ือนดังนี้ 
สมการวงรอบสําหรับความคลาดเคล่ือน : 

± x = ±(a+b+c+d+e+f)                   (1.4) 
       = ±(0.2+0.4+0.2+0.1+0.1+0.1) 
± x = ±1.1 

∴ G หรือ X ± x = 1.5 ± 1.1 
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 1.2.3 วิธีการของ Gladman 
 อันท่ีจริง Gladman ใชสมการวงรอบในการวิเคราะหความสัมพันธระหวางมิติมา
โดยตลอดโดยแยกเปนสมการสําหรับขนาดมูลฐานและสมการสําหรับความคลาดเคล่ือน ดังท่ีได
กลาวมาแลวในตอนตน และยังไมมีการต้ังกฎเกณฑการพิจารณากําหนดมิติใชงาน (function 
dimensions) ที่เก่ียวของกับความตองการใชงานแตอยางใด ที่เปนเชนนี้อาจเปนเพราะในงานดาน
วิศวกรรมเคร่ืองมือ  (tool engineering) ความรูในเร่ืองน้ีเปนความรูพื้นฐานของชางหรือผูมี
ประสบการณในทางปฏิบัติก็ได จนกระทั่ง Sermsuti-anuwat (2009) ไดสรุปแนวทางการประยุกต 
ใชของ Gladman และไดอธิบายขั้นตอนการเขียนแผนภาพวงรอบสําหรับงานประกอบไวอยางเปน
ระบบและชัดเจน เปนข้ันตอนดังนี้ 

 

 
 

รูปที่ 1.6 ชิ้นงานประกอบ 
 
 จากรูปที่ 1.6 แสดงช้ินงานประกอบท่ีมีชิ้นสวนประกอบท้ังหมด 4 ชิ้น (หมายเลข 
1-4) ความตองการใชงานในการประกอบนี้ คือ ระยะหางระหวางช้ินสวนที่ 4 และช้ินสวนที่ 1 ซึ่ง
เขียนแทนดวยมิติ X ± x เพื่อท่ีจะหามิติใชงานท่ีสงผลทําใหขนาดของชองวางเปล่ียนแปลงโดยการ
ใชแผนภาพวงรอบ สามารถทําไดอยางงายโดยมีขั้นตอนการวิเคราะหดังตอไปนี้ 
  1) เขียนลูกศรจากผิวแรกของมิติความตองการใชงานแลวเขียนหัวลูกศรไปยังอีก 

ผิวหน่ึงของชิ้นสวนเดียวกัน ซึ่งผิว ๆ นี้จะตองมีความสัมผัสกับผิวช้ินสวน 
อื่น ลูกศรหมายเลข 1 ในรูปที่ 1.6 คือผลลัพธของข้ันตอนน้ี โดยเร่ิมจากผิวของ
ชิ้นงานหมายเลข 1 ที่ติดกับชองวางแลวเขียนลูกศรไปยังผิวของช้ินสวน
หมายเลข 2 ในตําแหนงท่ีตรงขามกัน ลูกศรน้ีแสดงมิติใชงานของช้ินสวน
หมายเลข 1  
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ในการพิจารณาวามิติใดเปนมิติใชงานใหสังเกตดูวาความตองการใชงาน
เปล่ียนแปลงหรือไม เม่ือมิติที่พิจารณาเปล่ียนแปลงในขณะท่ีมิติอื่น ๆ คงท่ี 

  2) เขียนลูกศรหมายเลข 2 จากผิวท่ีสัมผัสกับหัวลูกศรหมายเลข 1 ไปยังอีกผิวหน่ึง 
ของชิ้นสวนหมายเลข 2 ที่ติดกับผิวของช้ินสวนหมายเลข 3 ลูกศรน้ีแสดงมิติใช 
งานของช้ินสวนหมายเลข 2 

  3) ทําซํ้าในขอที่ 2) จนกระท่ังลูกศรยอนกลับไปหาอีกขอบหนึ่งของมิติความ 
ตองการใชงาน จากน้ันใหหยุดกระบวนการทํางานก็จะไดแผนภาพวงรอบที่ 
เสร็จสมบูรณ มิติใชงานทั้งหมดที่มีผลตอขนาดของชองวางจะรวมอยูใน 
แผนภาพ 

 ซึ่งขั้นตอนท่ีกลาวมาน้ีจะคลายกับเทคนิคทั้งสองที่กลาวมาขางตน แตในบทความ
นี้ไดใหหลักเกณฑในการพิจารณามิติใชงานท่ีเกี่ยวของกับความตองการใชงานไววา ชิ้นสวน
ประกอบหน่ึงชิ้นจะตองที่มีมิติใชงานเพียงหนึ่งมิติเทานั้น เนื่องจากชิ้นสวนในงานประกอบหน่ึงช้ิน
จะมีเพียงสองดานที่สัมผัสกับช้ินสวนอ่ืน ๆ ซึ่งดานทั้งสองเปนมิติเชิงเสนตรงมิติเดียว นอกจากน้ัน
ยังไดเสนอแนะกฏเกณฑอันเปนวิธีการสรางความสัมพันธของตัวแปรในสมการวงรอบไวอกีดวย  

  

1.3 ปญหาของวิธีการเขียนแผนภาพวงรอบ 
 แมวาโดยท่ัวไปแผนภาพวงรอบจะเปนที่ยอมรับกันในเรื่องการหาความสัมพันธระหวาง
มิติที่เก่ียวของกับความตองการใชงาน แต แตละวิธีการหรือแตละเทคนิคจะมีรายละเอียดที่สะทอน
ถึงประสบการณของผูใชที่แตกตางกัน ตัวอยางเชน Drake แล Ligget ไมไดเนนถึงจํานวนมิติของ
ชิ้นงานแตละช้ินในสมการวงรอบ แต Gladman เนน 

ถาพิจารณาตัวอยางชิ้นงานประกอบของ Ligget โดยใชหลักเกณฑที่กลาวไวในบทความ
ของ Sermsuti-anuwat (2009) จะพบวามิติ J (แสดงเปนเสนประ) ของโครงดิสเบรกเปนมิติใชงานท่ี
เกี่ยวของกับ G สวน E และ F เปนผลของการเปล่ียนแปลงเดตัมของการบอกขนาดในโครงดิสเบรก
เทาน้ัน แตดวยประสบการณของ Ligget มิติ E และ F สามารถนํามาใชแทน J ได เพราะความคลาด
เคลื่อนของ E และ F เปนผลลัพธจากการกระจายความคลาดเคล่ือนของ J 

แผนภาพวงรอบสามารถแสดงความสัมพันธของมิติระหวางชิ้นงานไดดี แตกฏเกณฑใน
การเขียนแผนภาพวงรอบเพื่อใหไดมาซ่ึงสมการวงรอบน้ัน ยังไมสามารถครอบคลุมไปถึงกรณีของ
มิติหลายมิติในช้ินงานเดียวกันได  
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1.4 วิธีการทั่วไปสําหรับแบงคาความคลาดเคล่ือน (manual allocation of  
 tolerances) 

พิจารณาช้ินงานกลึง (stepped-shaft) ในรูปที่ 1.7 ซึ่งมีการบอกขนาดความยาวของสวน
ตาง  ๆ  4 มิ ติ  คือ  A ± a, B ± b, C ± c และ  D ± d จะเห็นไดว า  4 มิ ติบอกตําแหนงรูปลักษณ  5 
รูปลักษณ (หรือ 5 ผิว) หรือพูดไดวาจํานวนมิติจะนอยกวาจํานวนรูปลักษณที่มิติอางถึงอยู 1 เสมอ 
 

 
 

รูปที่ 1.7 ชิ้นงานกลึง 
 

 โดยหลักการในการบอกขนาดในแบบจะไมมีมิติ X ± x แตถาตองการทราบผิว m และ n 
จะหางกันเทาใด เม่ือชิ้นงานไดรับการตัดกลึงตามมิติอื่น ๆ ของชิ้นงาน X ± x จึงถูกสมมุติขึ้นเปน

ระยะหางระหวางผิว m และ n ดังน้ัน ถา X สูงสุด หรือ Xmax หรือ (X + x) จึงหาไดจาก:  

 

minminminmaxmax C -B  -A - D  X =  

 c)-(C-b)-(B-a)-(A-d)(D +=  
 d)db(a  C)-B-A-(D ++++=                (1.5) 
ในทํานองเดียวกัน 

 
 minX หรือ (X-x) maxmaxmaxmin CBAD −−−=  

 c)(C-b)(B-a)(A-d)-(D +++=  
 d)cb(a - C)-B-A-(D +++=                (1.6) 
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  ∴

d)cb(aC)BA(D
d)cb(aC)BA(D

X
X

min

max

+++−−−−
++++−−−

=   

 
หรือเขียนไดเปน 

 
       d)cb(a  C)-B-A-(D xX +++±=±                (1.7) 
 

เม่ือเขียนแยกเปนสมการวงรอบ 2 สมการจะได 
สมการสําหรับขนาดมูลฐาน : 

 
CBADX −−−=                 (1.8) 

 
สมการสําหรับความคลาดเคล่ือน : 

 
d)cb(ax +++±=±                 (1.9) 

 
 จะเห็นไดวาความเบี่ยงเบน ±x หรือ (ความคลาดเคล่ือน 2x)*นี้เปนผลรวมของความ
เบ่ียงเบน  (หรือความคลาดเคล่ือน) ของมิติอื่น  ๆ  ทั้งหมด  เราเรียกความเบ่ียงเบน  ±x หรือ 
(ความคลาดเคล่ือน 2x)*นี้วา ความคลาดเคล่ือนสะสม (tolerance stack) 

การประยุกตใชงานท่ีเกิดขึ้นอยูเสมอ คือ เม่ือเดตัมของการบอกขนาดในแบบไมเหมือนกับ
เดตัมของการผลิต (manufacturing datum) ตัวอยางเชน ในรูปท่ี 1.8 แสดงแบบช้ินงานหลอ ซึ่งตอง 
การกลึงเพลาและกัด (milling) ใหเปนรอง ถาตองทําตามแบบจริง ๆ ก็ตองปาดหนา (facing) ผิว A 
และ D กอนแลวจึงกัดรองลึก 14.925±0.075 mm แลวจากนั้นจึงกลึง (เพราะตองวัด 35.5±0.15 mm 
จากกนรอง) แตในทางปฏิบัติจะทํางานกลึงกอนแลวจึงกัดรอง นั้นคือ ตองทราบมิติ X2±x2 ถึงจะ
กลึงได ซึ่งสามารถหาไดจากสมการ 1.8 และ 1.9 ดังนี้ 
 

สมการขนาดมูลฐาน :       X2 – 14.925 = 35.5  

∴X2 = 50.425 
 
______________________________________________________________________________ 
* แมวาความคลาดเคลื่อนของมิติคอืความแตกตางของขนาดใหญสุดกับขนาดเล็กสุดก็ตาม แตในเร่ืองของการ
วิเคราะหความคลาดเคล่ือนนั้น นิยมเรียกความเบ่ียงเบนเปนความคลาดเคล่ือนเชน ความคลาดเคล่ือน ±x ซึ่งใน
ความหมายจริง คือ 2x 
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สมการความคลาดเคล่ือน :  ± (x2 + 0.075) ≤ ± 0.15  

∴x2 = ± 0.075 

∴ X2 ± x2 = 50.425 ± 0.075 mm 

 

 
 

รูปที่ 1.8 แบบของชิ้นงานตัด-กลึง 
 

1.5 กราฟตนไม (rooted-tree graph) 
 เนื่องจากการใชคาสูงสุดและคาตํ่าสุดคํานวณความคลาดเคล่ือนสะสมเปนวิธีที่ลาชา ยาก
แกการตรวจสอบและไมสะดวกตอการผูกเปนสมการ จึงจําเปนตองคนหาวิธีการอื่นท่ีเหมาะสมกวา 
การใชกราฟตนไมโดย  Whybrew, Britton, Robinson and Sermsuti-anuwat (1990) ประสบผล 
สําเร็จ  ในการสรางความสัมพันธระหวางรอยตัดของแผนภูมิความคลาดเคล่ือน  (tolerance 
charts) โดยกราฟดังกลาวสามารถบันทึกความสัมพันธของความคลาดเคล่ือนของทุกรอยตัดต้ังแต
เริ่มตนจนสําเร็จเปนช้ินงานตามขอกําหนดในแบบ 

ในงานวิจัยนี้อาศัยแนวความคิดดังกลาว โดยถือวามิติแตละมิติในช้ินงาน คือ รอยตัดท่ีเกิด
จากแตละข้ันตอนของการตัดโลหะ เพราะฉะนั้นจึงสามารถท่ีจะนํากราฟตนไมมาใชสราง
ความสัมพันธระหวางความคลาดเคล่ือนได และมีการนําแนวความคิดของการใชกราฟตนไมไป
สรางเง่ือนไขสําหรับแกปญหาดวยสมการเชิงเสนแลวหาคําตอบดวย Excel (อรวรรณ นงนุช และ 
ยงยุทธ เสริมสุธีอนุวัฒน, 2552) ซึ่งไดผลเปนท่ีนาพอใจ  

เพื่อแสดงการประยุกตใชวิธีการกราฟตนไม พิจารณารูปที่ 1.8 อีกครั้ง ตัวเลขบอกขนาด
ดานบนของรูป คือ ตัวเลขบอกขนาดตามแบบ เราจะเรียกวา มิติชุดเกา ซึ่งใชผิว C เปนระนาบ
อางอิงใหกับผิว B และผิว D เปนการบอกขนาดท่ีไมเหมาะสมสําหรับการผลิต เน่ืองจากถาให
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ผิว C เปนผิวอางอิงของการบอกขนาด ดังน้ันผิว C จะตองไดรับการกัดรองกอนเพื่อเปนผิวอางอิง
ใหกับผิว B และผิว D แตปญหาท่ีจะเกิดตามมาก็คือ ความยุงยากในการต้ังเคร่ืองมือตัด (tool set-
up) จะเพิ่มมากขึ้นและการวัดขนาดของความยาวท่ีจะตองกลึงปอกของ Ø39 ซึ่งสัมพันธกับ
ผิว C เพราะฉะน้ันจึงจําเปนตองเปล่ียนแปลงระนาบอางอิงของการบอกขนาดในแบบใหเหมาะสม
กับระนาบอางอิงในการผลิตและการตรวจสอบใหม คือ ใชผิว D เปนระนาบอางอิงใหกับผิว B และ
ผิว C โดยการบอกขนาดของมิติชุดใหมนี้อยูทางดานลางของรูป สําหรับปญหาในรูปที่ 1.8 เรา
สามารถเขียนกราฟไดดังรูปที่ 1.9 และสามารถสรางสมการวงรอบจากกราฟไดดังนี้ 

 

 
 

รูปที่ 1.9 กราฟตนไม 
 

สมการวงรอบขนาดมูลฐาน:  
 X1 = Y1               (1.10) 
 
 X2-X1 = Y2               (1.11) 

 
สมการวงรอบสําหรับความคลาดเคลื่อน : 

 x1 ≤ y1                (1.12) 
 
 x1+x2 ≤ y2                (1.13) 
 
 จะเห็นไดวาสมการสําหรับขนาดมูลฐานจะบวกหรือลบกันตามเคร่ืองหมาย แตสมการของ
คาความคลาดเคล่ือนจะเปนผลบวกเสมอ ซึ่งในการกระจายความคลาดเคล่ือนน้ันจะอาศัยสมการท่ี 
(1.12) และ (1.13) กลาวคือ ผลรวมของความคลาดเคล่ือนของมิติใหมตองไมเกินความคลาดเคล่ือน
ของมิติเดิมที่กําหนดไวแลว  
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1.6 วัตถุประสงค 
วัตถุประสงคหลักในการทํางานวิจัยครั้งน้ี คือ การเขียนโปรแกรมคอมพิวเตอรเพื่อนํามาใช

สําหรับแบงคาความคลาดเคล่ือนใหเหมาะสมกับมิติชุดใหมเม่ือจุดอางอิงของการผลิตและการ
ตรวจสอบแตกตางไปจากจุดอางอิงของการบอกขนาดในแบบ โดยอาศัยเทคนิคของกราฟตนไมใน
การหาความสัมพันธของสมการใหอยู ในรูปแบบของการโปรแกรมเชิงเสนตรง  (linear 
programming) และหาผลลัพธโดยใชเทคนิคการหาคาที่เหมาะสม (optimization techniques) เพื่อให
แนใจไดวาความคลาดเคล่ือนท่ีถูกกําหนดใหกับมิติทั้งหมดน้ันมีคามากท่ีสุดภายใตเงื่อนไข
ความสัมพันธของมิติและขณะเดียวกันก็ตองอยูในเกณฑที่สามารถผลิตไดดวยกระบวนการผลิต
โดยเฉลี่ย (average processing conditions) และนอกจากนี้ยังมีวัตถุประสงครองเพื่อหาวิธีที่สะดวก
และรวดเร็วสําหรับคํานวณหรือตรวจสอบความคลาดเคล่ือนสะสมเพ่ือใชเปนพื้นฐานสําหรับการ
วางแผนข้ันตอนในการตัดโลหะ (machining sequence) ตลอดจนสามารถนําไปใชในการออกแบบ
อุปกรณยึด (work holding devices) เชน จิกและฟกซเจอรได 
 

1.7 ขอบเขตและสมมุติฐานของงานวิจัย 
การวิจัยน้ีจะเปนเรื่องของความคลาดเคล่ือนของมิติเชิงเสนตรงธรรมดา (conventional 

tolerancing method) เทาน้ันโดยสมมุติวาเคร่ืองมือกลมีความสามารถในสภาพเฉล่ีย ซึ่งสามารถให
ค าความคลาด เค ล่ือนตามมาตรฐาน  ISO 286-2 และไม รวม ถึงความคลาด เค ล่ือน เ ชิ ง
เรขาคณิต  (geometric tolerance) และยังคงอยูกับแนวความคิดของการผลิตแบบสับเปลี่ยน
ได  100% (100% interchangeable manufacture) เพี ยงอย าง เดี ยว  นั่นคือ  ยั งไมรวมไปถึ งการ
ประยุกตใชหลักสถิติกับความคลาดเคล่ือนทั้งหลายท่ีเกี่ยวของ 
 

1.8 สรุป 
ปญหาการกระจายหรือแบงคาความคลาดเคล่ือน เกิดขึ้นจากปญหาความคลาดเคลื่อน

สะสมของช้ินงานท่ีมีระนาบอางอิงในการผลิตแตกตางไปจากระนาบอางอิงในการบอก
ขนาด ดังนั้นผูวางแผนกระบวนการผลิตจําเปนตองกระจายคาความคลาดเคลื่อนใหกับมิติ 
(dimensions) ในการผลิตหรือในการวัดขนาดใหมเพื่อใหความตองการใชงานของช้ินงาน 
(functional requirement) คงเดิม การวิเคราะหความคลาดเคล่ือนชนิดน้ีอาศัยเทคนิคของแผนภาพ
วงรอบ ซึ่งเปนวิธีการท่ีนิยมใชในอุตสาหกรรมมาเปนเวลานานกวา 50 ป  

แผนภาพวงรอบเปนเทคนิคท่ีใชในการแสดงความสัมพันธของความตองการใชงานของชุด
งานประกอบกับมิติใชงานของช้ินสวนประกอบแตละช้ินเพื่อใชสรางสมการวงรอบ ซึ่งเปนวิธีการ
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ที่ใชสําหรับการคํานวณเพื่อปรับปรุงแบบของชิ้นงานใหสะดวกตอการผลิต นอกจากน้ันการใช
สมการวงรอบสามารถลดความชํานาญและประสบการณของผูออกแบบกระบวนการ
ผลิต (process planner) ได แตอยางไรก็ตามวิธีการน้ีก็ยังมีขอจํากัดในเร่ืองของการนําไปใชกับ
ชิ้นงานท่ีมีรูปรางซับซอน ซึ่งยังคงเปนปญหาของการออกแบบทางวิศวกรรม ดังน้ันจึงไดมีการ
พัฒนารูปแบบของการคํานวณโดยการประยุกตใชเทคนิคกราฟตนไมกับเทคนิคการหาคาที่
เหมาะสมใหอยูในรูปแบบของโปรแกรมคอมพิวเตอรเพื่อใหสามารถนําไปใชในการออกแบบ
ชิ้นงานที่มี่รูปรางซับซอนไดงายและรวดเร็วมากยิ่งขึ้น 



 

 

 

 

 

 

 

 

บทที่ 2 
ปริทัศนวรรณกรรมและงานวิจัยที่เกี่ยวของ 

 

 การวิเคราะหความคลาดเคลื่อน (tolerance analysis) เปนเรื่องเกี่ยวกับการพิจารณาแยก
องคประกอบของความคลาดเคล่ือนของความตองการใชงานออกเปนสวน ๆ กําหนดความคลาด
เคล่ือนท่ีเหมาะสมใหกับแตละองคประกอบยอยและประเมินความสัมพันธขององคประกอบ
ทั้งหลายท่ีมีผลตอการใชงาน เพราะฉะนั้น เรื่องของการวิเคราะหความคลาดเคล่ือนของชุดงาน
ประกอบจึงครอบคลุมต้ังแตแยกความคลาดเคลื่อนของชุดงานประกอบหรือของมิติในช้ินสวนแต
ละช้ินแลวแบงหรือกําหนดคาความคลาดเคล่ือนท่ีเหมาะสม ซึ่งเรียกวา tolerance allocation ไป
จนถึงการสรางความสัมพันธระหวางความคลาดเคล่ือนที่เรียกวา tolerance chain หรือ tolerance 
relationship  
 

2.1 วิธีการวิเคราะหความคลาดเคล่ือน 
 วิธีการวิเคราะหความคลาดเคล่ือนแยกออกไดเปน 2 แบบ คือ วิธีการวิเคราะหในช้ินงาน
ประกอบและวิธีวิเคราะหในชิ้นงานเดี่ยว ซึ่งแตละวิธีแมวาจะมีความแตกตางกันในรายละเอียดของ
การดําเนินการ แตถาสามารถสรุปไดเปนสมการแสดงความสัมพันธระหวางมิติหรือความ
คลาดเคลื่อนในรูปแบบเดียวกัน คือ สมการวงรอบ (loop equation) สําหรับขนาดมูลฐานและ
สําหรับความคลาดเคล่ือน 

2.1.1 การวิเคราะหความคลาดเคลื่อนในช้ินงานประกอบ 
 การวิเคราะหความคลาดเคล่ือนในช้ินงานประกอบสวนใหญอาศัยการพิจารณา

จากแผนภาพประกอบแลวใชประสบการณกําหนดมิติใชงาน  (functional dimensions) ที่มี
ผลกระทบตอความตองการใชงาน (functional requirement) ของชุดงานประกอบ ดังท่ีไดกลาว
มาแล ว ในบท ท่ี  1 ใน เ รื่ อ งของการสร า งสมการวงรอบจากกฎ เกณฑของ  Drake หรือ 
ของ Ligget เปนตน ซึ่งผลของการวิเคราะหก็คือ สมการแสดงความสัมพันธของความคลาดเคล่ือน
ของมิติในช้ินงานท่ีเปนองคประกอบ วิธีการเหลาน้ีเปนวิธีการที่ผูชํานาญใชในทางปฏิบัติอยู
เสมอ และมีหลักการใหญ ๆ คลาย ๆ กัน เพียงแตมีรายละเอียดท่ีแตกตางกันตามประสบการณของ
แตละบุคคลเทาน้ัน นอกจากน้ียังมีความแตกตางกันในการเรียกความสัมพันธ เชน สมการ
วงรอบ (loop equations) และ ลูกโซความสัมพันธ (chain relationship) เปนตน 
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 นักวิจัยทางดานเทคโนโลยีความคลาดเคล่ือน (tolerance technology) ตระหนักถึง
ความสัมพันธเชนนี้มานานไมนอยกวา 70 ป ดังที่ Early and Johnson (1962) ไดใหความสําคัญตอ
การวิเคราะหความคลาดเคลื่อนในงานทางดานวิศวกรรมเคร่ืองมือและในการวางแผนกระบวนการ
ผลิต (process plainning) ตามลําดับ 

 การประยุกตใชความสัมพันธลูกโซที่ เดนชัดที่สุดปรากฎอยู ในงานของ 
Bjørke (1978) โดยการนําสมการดังกลาวไวในโปรแกรมท่ีเขาพัฒนาขึ้นสําหรับวิเคราะหความ
คลาดเคลื่อนเชิงเสนตรงของชุดงานประกอบ อยางไรก็ตาม เนื่องจากความแตกตางในกฎเกณฑการ
สรางสมการหรือความสัมพันธของความคลาดเคล่ือนของมิติทําใหยากแกการประยุกตใช Sermsuti-
anuwat (2009) จึงไดสรุปหลักการของ Gladman เพื่อใหการสรางความสัมพันธของมิติเชิงเสนตรง
สามารถใหคําตอบเดียวกัน เปนกฎเกณฑ 3 ขอ ดังที่ไดกลาวมาแลว ที่สําคัญคือ มิติใชงานใน
ชิ้นสวนประกอบหน่ึง ๆ จะมีเพียงมิติเดียวเทานั้น 

2.1.2 การวิเคราะหความคลาดเคลื่อนในช้ินงานช้ินเดียว 
 เปนการวิเคราะหความคลาดเคล่ือนที่เกิดจากระนาบอางอิงในการผลิตแตกตางจาก

ระนาบอางอิงในการออกแบบ วิธีวิเคราะหที่นิยมใชในทางปฏิบัติและเปนวิธีดั้งเดิม คือ การหา
คาสูงสุดและคาตํ่าสุดของมิติที่สนใจ จากมิติที่มีอยูทั้งหมด ดังท่ีไดกลาวมาแลวในบทที่ 1 แตขอเสีย
ของวิธีนี้คือ ตองอาศัยประสบการณของผูวิ เคราะหและเสียเวลาในการตัดสินใจเลือกมิติที่
เกี่ยวของ การวิเคราะหความคลาดเคล่ือนท่ีจัดวาเปนระบบมากท่ีสุด คือ การสรางแผนภูมิความ
คลาดเคล่ือน ซึ่งใชในทางปฏิบัติต้ังแตตนศตวรรษท่ี 20 จนมีบทความแสดงผลงานวิจัยอยาง
ตอเนื่องในชวง ค.ศ. 1950 เศษ ๆ อยางไรก็ตาม เทคนิคหรือวิธีการน้ียังคงจํากัดอยูในวงแคบเพราะ
ตองใชเวลาทําแผนภูมิมากและหลักการของแผนภูมิเองก็ยังยากแกการทําความเขาใจ จนกระทั้งเม่ือ
ป ค.ศ. 1984 Ahaluwalia and Korolin (1984) ไดตีพิมพบทความของการประยุกตใชคอมพิวเตอร
สรางแผนภูมิความคลาดเคลื่อน เทคนิคนี้จึงฟนกลับคืนมาอีกครั้ง และในปเดียวกันนั้นเอง 
Farmer and Harris (1984) ไดแสดงการกระจายความคลาดเคล่ือนใหกับมิติตาง ๆ ดวยคอมพิวเตอร 
 ทั้งแผนภูมิความคลาดเคล่ือนและผลงานของ Farmer and Harris (1984) ตางก็เปน
การวิเคราะหความคลาดเคล่ือนสะสมและมีผลตอความตองการใชงานของช้ินสวนท่ีพิจารณา 
ถึงแมวา  Farmer and Harris จะใชสมการความคลาดเคล่ือนเปนหลักในการกระจายความ
คลาดเคล่ือน แตการกําหนดมิติใชงานในสมการความคลาดเคล่ือนยังคงตองอาศัยประสบการณ
ในทางปฏิบัติเปนสําคัญ 
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2.2 การใชคอมพิวเตอรชวยในการวิเคราะหความคลาดเคล่ือน 
การใชคอมพิวเตอรวิเคราะหความคลาดเคล่ือนอยางจริงจังมีมานานกวา 30 ป ผลงาน

ของ Bjørke (1978) แสดงใหเห็นถึงความสําเร็จในการพัฒนาโปรแกรมสําหรับคํานวณคาความ
คลาดเคล่ือนสะสม และทําการหาคาความคลาดเคล่ือนที่เหมาะสมในเครื่องคอมพิวเตอรขนาด
ใหญ  (mainframe) แตในเวลานั้นงานวิจัยด านน้ียั งอยู ในวงแคบ  ซึ่ งอาจเปนเพราะว าขีด
ความสามารถท่ีจํากัดของเครื่องคอมพิวเตอรเองหรือราคาคอมพิวเตอรที่ยังสูงอยู บทบาทของ
คอมพิวเตอรเร่ิมชัดเจนข้ึนเม่ือ Ahaluwalia and Karolin (1984) รายงานการใชคอมพิวเตอรสราง
แผนภูมิความคลาดเคลื่อน (tolerance chart) และในปเดียวกัน Farmer and Harris (1984) ไดพัฒนา
โปรแกรมคอมพิวเตอรสําหรับคํานวณคาคลาดเคล่ือนใหกับมิติตาง ๆ ที่ถูกกําหนดขึ้นเม่ือเกิดการ
เปล่ียนแปลงเดตัมของการบอกขนาดในแบบวิศวกรรมโดยใชวิธีการสรางสมการวงรอบเปน
พื้นฐานของการกระจายคาความคลาดเคล่ือน ผลงานที่กลาวขางตนอาจถือไดวาเปนจุดเริ่มตนของ
การประยุกตใชคอมพิวเตอรสําหรับวิเคราะหความคลาดเคล่ือนใหเปนไปอยางกวางขวาง และ
หลังจากน้ัน Fainguelernt, Weill and Bourdet (1986) พยายามแสดงใหเห็นถึงความเปนไปไดใน
การคํานวณหาขนาดและคาความคลาดเคลื่อนบนเคร่ืองคอมพิวเตอรขนาดเล็ก (micro computer) 
โดยใชเทคนิคการหาคาที่เหมาะสมดวยวิธีการโปรแกรมเชิงเสนตรง 
 

2.3 การประยุกตใชเทคนิคกราฟในการวิเคราะหความคลาดเคล่ือน 

การนําเทคนิคของกราฟมาประยุกตใชกับการสรางความสัมพันธของความคลาดเคล่ือน
เปนวิธีหนึ่งที่ทําไดงายและสามารถนําไปสรางเปนแบบจําลองทางคณิตศาสตร (mathematical 
model) โดยใชความเชื่อมโยงของเสนทาง (path) ที่แสดงความสัมพันธของมิติตาง ๆ เปนตัวสราง
สมการความสัมพันธของความคลาดเคล่ือน เพื่อใชในการคํานวณหาคาท่ีเหมาะสมดวยวิธีการ
โปรแกรมเชิงเสนตรง  
 จากงานวิจัยของ Irani, Mittal and Lehtihet (1989) ไดนําเสนอการใช directed graph เพื่อ
สรางความสัมพันธระหวางรอยตัดของแผนภูมิความคลาดเคล่ือนโดยใชวิธีการท่ีเรียกวา path-
tracing ในการบงช้ีความเช่ือมโยงของความคลาดเคล่ือน อยางไรก็ตาม วิธีการนี้ก็ยังเปนวิธีที่ยากตอ
การนําไปใชในทางปฏิบัติเพราะไมสามารถบงช้ีผิวหนาในการตัด (machined surface) ที่แนนอนได
และมีกฏเกณฑที่ซับซอน 
 
 
 



 

 

 

 

 

 

 

 

  

19 

2.4 การใชเทคนิคกราฟตนไมในการทําแผนภูมิความคลาดเคล่ือน 
Whybrew, Britton, Robinson and Sermsuti-anuwat (1990) ไดประ ยุกต ใชกราฟตนไม 

(rooted-tree graph) สําหรับชวยสรางแผนภูมิความคลาดเคล่ือน ซึ่งไดอธิบายถึงวิธีการสรางกราฟ
ตนไม (rooted-tree graph) สําหรับการลําดับขั้นตอนการตัดโลหะในแผนภูมิความคลาดเคล่ือนโดย
มีรายละเอียดดังนี้ 
 

 
 

รูปที่ 2.1 ชิ้นงานสําเร็จจากการตัดโลหะมิติตาง ๆ (Whybrew et al., 1990) 

 

 
 

รูปที่ 2.2 แผนภูมิความคลาดเคล่ือน (Whybrew et al., 1990) 
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จากรูปที่ 2.2 แสดงข้ันตอนการตัดโลหะที่เรียกวา แผนภูมิความคลาดเคล่ือนซึ่งสามารถ
สรุปขั้นตอนไดดังนี้  

ขั้นตอนท่ี 1 Operation 10 เล่ือยตัด ไดผวิ A โดยอางอิงจากผิว D 
ขั้นตอนท่ี 2 Operation 30 กลึงตัด ไดผวิ B โดยอางอิงจากผิว D 
ขั้นตอนท่ี 3 Operation 40 กลึงตัด ไดผวิ A1 โดยอางอิงจากผิว D  
ขั้นตอนท่ี 4 Operation 50 กลึงตัด ไดผวิ D1 โดยอางอิงจากผิว A1  
ขั้นตอนท่ี 5 Operation 60 เจาะรู ไดผวิ C โดยอางอิงจากผิว A1  
ขั้นตอนท่ี 6 Operation 70 กลึงตัด ไดผวิ C1 โดยอางอิงจากผิว A1 
ขั้นตอนท่ี 7 Operation 80 เจียระไน ไดผวิ A2 โดยอางอิงจากผิว D1  
ขั้นตอนท่ี 8 Operation 90 เจียระไน ไดผวิ D2 โดยอางอิงจากผิว A2 
 
จากการพิจารณาขั้นตอนทั้งหมดสามารถสรุปความสัมพันธที่ถูกตัดและผิวที่เปนจุดอางอิง

ในการวัดขนาดไดดังตารางท่ี 2.1 และสามารถแสดงเปนกราฟตนไมไดดังรูปที่ 2.3 
 

ตารางท่ี 2.1 แสดงความสัมพันธของผิวท่ีถูกตัดและผิวท่ีเปนจุดอางอิงในการวัดขนาด (Whybrew et  
 al., 1990) 

การดําเนินการ 
(Operation) 

ผิวท่ีถูกตัด 
(machined face) 

จุดอางอิงในการวัดขนาด 
(location face) 

10 
30 
40 
50 
60 
70 
80 
90 

A 
B 

A1 
D1 
C 
C1 
A2 
D2 

D 
D 
D 
A1 
A1 
A1 
D1 
A2 
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รูปที่ 2.3 กราฟตนไม (Whybrew et al., 1990) 
 

 จากกราฟตนไมในรูปท่ี 2.3 เราสามารถคํานวณความคลาดเคล่ือนของมิติที่สนใจได
เชน มิติระหวางผิว A2 กับผิว B จะมีความคลาดเคล่ือนเทากับผลรวมของความคลาดเคล่ือนของการ
ตัดท่ีอยูในเสนทางระหวางผิว A2 และผิว B นั่นคือ ผลรวมของความคลาดเคล่ือนของ B - D, D -
 A1, A1 - D1 และ D1 - A2 เทากับ ± (0.025+0.025+0.025+0.005) = ±0.080 mm เปนตน 

วิธีการของ Whybrew et al. (1990) เปนวิธีที่งายตอการทําความเขาใจและไมตองอาศัย
กฎเกณฑที่ยุงยากซับซอนและสามารถนํามาประยุกตใชในการสรางความสัมพันธของมิติไดอยาง
ดี จึงเปนจุดเริ่มตนในการนําไปสรางเปนแบบจําลองทางคณิตศาสตรของสมการเชิงเสนตรงเพื่อให
สามารถดําเนินการไดงายบนคอมพิวเตอร โดย Ngoi (1992) และ ji (1993)ไดใชเทคนิคของกราฟ
ตนไมสรางแบบจําลองทางคณิตศาสตรสําหรับการกําหนดความคลาดเคล่ือนในแผนภูมิความ
คลาดเคล่ือน โดยนําเสนอตัวอยางในการเปรียบเทียบ การแกปญหาระหวางวิธีโปรแกรมเชิง
เสนตรงกับวิธีการคํานวณแบบลองผิดลองถูกดวยมือ (Eary and Johnson, 1962) จากน้ันก็มีการนํา
แบบจําลองทางคณิตศาสตรนี้ไปพัฒนาตอเพื่อหาขนาดท่ีเกิดจากการตัดในแตละครั้ง (working 
dimensions) และแบงความคลาดเคล่ือนโดยอัตโนมัติในแผนภูมิความคลาดเคล่ือน (Ngoi and 
Ong, 1993a; 1993b) ซึ่งใชเทคนิคท่ีเรียกวา path-tracing technique และแกปญหาโดยใชระบบของ
สมการเชิงเสนตรง นอกจากน้ันยังสามารถนําไปใชอธิบายวิธีการจัดลําดับกระบวนผลิตในแผนภูมิ
ความคลาดเคล่ือนโดยอัตโนมัติ (Ngoi and Fang, 1994; Ngoi and Cheong, 1998) ซึ่งงานวิจัยท่ี
กลาวมาขางตนยังคงตองอาศัยโปรแกรม LINDO ในการหาผลลัพธที่ เหมาะสมท่ีสุดใหกับ
แบบจําลองทางคณิตศาสตรที่สรางขึ้นมา 
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นอกจากน้ีเทคนิคของกราฟตนไมยังสามารถนําไปประยุกตใชในเขียนโปรแกรม
คอมพิวเตอรชวยในการวางแผนกระบวนการผลิต (Sermsuti-anuwat, Whybrew and McCallion, 
1995) และยังนําไปใชแสดงความสัมพันธระหวางการออกแบบกับการวางแผนการผลิตในช้ินงานท่ี
มีรูปทรงสามมิติไดอีกดวย (Thimm, Britton and Fok, 2004)  
 

2.5 วิธีการสรางกราฟตนไมเแสดงความสัมพันธของความคลาดเคล่ือน 
เม่ือพิจารณาการใชเทคนิคกราฟตนไมในการบันทึกรอยตัดในแผนภูมิความคลาดเคล่ือน 

จะเห็นไดวาความสัมพันธของความคลาดเคล่ือนของรอยตัดทุกรอยตั้งแตตน จนเปนชิ้นงาน
สําเร็จรูป สามารถสรุปไดเปนกราฟชุดเดียว เพราะฉะน้ันเราอาจพิจารณาวาเม่ือมิติชุดใหมมีระนาบ
อางอิงของการบอกขนาดเปล่ียนแปลงเกิดจากมิติชุดเกาที่ถูกตัดมากอน นั้นคือ เราสามารถใช
เทคนิคกราฟตนไมแสดงความสัมพันธของความคลาดเคล่ือนระหวางมิติชุดเกาและมิติชุดใหมได 

รูปท่ี 2.4 แสดงช้ินงานกลึงเพลาเหล็กกลาซึ่งและมีการบอกขนาดความคลาดเคล่ือนของมิติ
ความยาวเปนคาเบ่ียงเบนเทา ๆ กันจากขนาดมูลฐาน (equally bilateral tolerancing) เพื่อใหเขาใจได
งายขึ้น  ในรูปนี้ได เขียนกํากับมิติ เกาทุกมิติดวยสัญลักษณของการบอกขนาดเปน  (Y1±y1) 
ถึง (Y4±y4) ซึ่งเปนมิติที่อยูดานบนท้ังหมดของรูปและกําหนดให (X1±x1) ถึง (X4±x4) เปนมิติ
ใหมเม่ือระนาบอางอิงของการบอกขนาดเปล่ียนแปลง ซึ่งอยูดานลางท้ังหมดของรูป และใช
ตัวอักษร A ถึง E แทนผิวช้ินงานที่เกี่ยวของกับมิติของขนาด 

 

 
 

รูปที่ 2.4 ชิ้นงานตัวอยางสําหรับการคํานวณมิติความยาว 4 มิติ 
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วิธีการสรางความสัมพันธของความคลาดเคล่ือนของมิติชุดเกาและมิติชุดใหมจะอาศัยการ
สรางกราฟตนไมของมิติใหมเปนหลักในการกําหนดความสัมพันธ โดยมีขั้นตอนดังนี้  

1) สเก็ตชภาพฉายต้ังฉากของช้ินงานที่แสดงมิติซึ่งเกี่ยวของกับการเปล่ียนแปลงระนาบ 
อางอิง และกําหนดชื่อเปนตัวอักษรใหกับผิวงานที่เปนขอบเขตของขนาดท้ังหมด  
(ผิว A, B, C, D, E ในวงกลมของรูปที่ 2.4) 

2) สรางกราฟสําหรับมิติใหมในรูปที่ 2.4 โดยการเขียนตัวอักษรของผิวเริ่มตนไวตอน 
บนสุด โดยเร่ิมจากผิวใดของช้ินงานก็ได ในรูปที่ 2.5 เริ่มจาก A และเรียก A วา 
โหนด (node) A  

3) พิจารณาวามีมิติใดบางที่เกี่ยวของกับโหนดเริ่มตนน้ี ใหลากลูกศรออกจากโหนดเร่ิมตน 
ชี้ไปยังอักษรที่ระบุผิวปลายของมิติเหลานั้น ผลของขั้นตอนน้ี คือเสนเชื่อมโยง (links)  
AB, AC, และ AE ของมิติ X1 และ X2 และ X3 ตามลําดับ และมีโหนดท่ีเกิดขึ้นใหม 
คือ B, C และ E 

4) พิจารณาโหนดที่เกิดขึ้นใหมคือ B, C และ E โดยลากลูกศรออกจากโหนดแลวทํา 
เชนเดียวกับขั้นตอนท่ี 3 จนครบทุกมิติ จะไดกราฟตนไมของมิติใหมที่สมบูรณ ดังรูป 
ที่ 2.5 

 

 
 

รูปที่ 2.5 กราฟตนไมสําหรับมิติใหม 
 

จากกราฟตนไมรูปที่ 2.5 เราสามารถสรุปความสัมพันธระหวางความคลาดเคล่ือนของมิติ
ชุดเกาและเสนทางของกราฟท่ีเกี่ยวของกับมิติชุดใหมไดดงัตารางที่ 2.2 
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ตารางที่ 2.2 ความสัมพันธของความคลาดเคล่ือนของมิติเกาและมิติใหม 
ความคลาดเคล่ือนของมิติเกา ผิวช้ินงานของมิติเกา ความคลาดเคล่ือนของมิติใหม 

y1 (±0.12) AB x1 
y2 (±0.08) BC x1, x2 
y3 (±0.08) CD x2, x3, x4 
y4 (±0.10) DE x4 

 
2.6 การโปรแกรมเชิงเสนตรงกับการกระจายความคลาดเคล่ือน 
 การโปรแกรมเชิงเสนตรง หมายถึง ระเบียบวิธีทางคณิตศาสตรเพื่อหาคาที่เหมาะสมท่ีสุด
ซึ่งเปนคาสูงสุด (maximize) หรือตํ่าสุด (minimize) ของเปาหมายท่ีกําหนด ภายใตเง่ือนไขบาง
ประการ โดยเปาหมายจะตองแสดงอยูในรูปสมการเสนตรง สําหรับเงื่อนไขอาจอยูในรูปสมการ
หรืออสมการเสนตรงก็ได 

2.6.1 สมการเปาหมาย (objective function)  
 สมการเปาหมายสําหรับปญหาการกระจายคาความคลาดเคล่ือน คือ การสราง

สมการเชิงเสนตรงแสดงความสัมพันธระหวางมิติเกากับมิติใหม โดยใชหลักการคือ ผลรวมของ
ความคลาดเคล่ือนสะสมของมิติใหมจะตองมีคามากที่สุดเพื่อใหสามารถผลิตไดงายและช้ินงานทํา
หนาที่ไดเสมอ โดยสามารถเขียนเปนรูปแบบของสมการเปาหมายไดดังนี้ 

 
Max Z = x1 + x2 + ... + xn  โดยที่ i =1,…,n              (2.1) 

 
 กําหนดให xi = คาความคลาดเคลื่อนที่มิติใหมใด ๆ 
  n = จํานวนของมิติทั้งหมด 

2.6.2 สมการขอจํากัด (constraints) 
 สมการขอจํากัดของปญหาปญหาการกระจายคาความคลาดเคล่ือน นั้นสามารถ

แบงออกเปน 2 เงื่อนไขดังนี้ 
 1) ผลรวมของความคลาดเคล่ือนสะสมของมิติใหมจะตองมีคานอยกวาความ
คลาดเคล่ือนของมิติเกาท่ีเก่ียวของเพื่อใหชิ้นงานสามารถใชงานไดเสมอ ซึ่งสามารถสรางอสมการ
แสดงความสัมพันธระหวางมิติชุดเกาและมิติชุดใหมได เชน มิติเกา Y3 ระหวางผิว C และ D ใน
แบบ  (รูปที่  2.4) จะเกิดจากเสนทางในกราฟ  (รูปที่  2.5)  จาก  C ถึง  D ประกอบดวยมิติ  X2 
X3 และ  X4 ซึ่งจะเขียนเปนอสมการแสดงความสัมพันธของความคลาดเคล่ือนของมิติได
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เปน x2+x3 + x4 ≤ y3 และสามารถเขียนรูปแบบของสมการขอจํากัดไดดังนี้ 
 

x1 ≤ y1   โดยที่ i =1,…,n              (2.2) 
 
       x1+ x2 ≤ y2   โดยที่ i =1,…,n              (2.3) 
 
  x2+x3+ x4 ≤ y3   โดยที่ i =1,…,n              (2.4) 
 

x4 ≤ y4   โดยที่ i =1,…,n              (2.5) 

 
 กําหนดให yi = คาความคลาดเคลื่อนที่มิติใหมใด ๆ 
  n = จํานวนของมิติทั้งหมด 
 2) ขอจํากัดท่ีเก่ียวกับกระบวนการผลิตตองมีความสามารถในการผลิตไมนอยกวา
คาเกรดความคลาดเคล่ือนสากล (International Tolerance Grade ISO 286-1) (รายละเอียดแสดงใน
ภาคผนวก ก) ซึ่งสามารถเขียนรูปแบบของสมการขอจํากัดไดดังนี้ 
 

xi ≥ เกรดความคลาดเคล่ือนสากล  โดยที่ i =1,…,n              (2.6) 

 
 จากช้ินงานตัวอยางในรูปที่ 2.4 สามารถสรุปเปนตัวแบบของปญหาโปรแกรมเชิง
เสนตรงท้ังหมดไดดังนี้ 
 สมการเปาหมาย 

 
Max Z = x1 + x2 + x3 + x4                 (2.7) 

 
 สมการขอจํากัด 

 
x1 ≤ 0.12                 (2.8) 
 

      x1 + x2 ≤ 0.08                 (2.9) 
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            x2 + x3 + x4 ≤ 0.08               (2.10) 
 

x4 ≤ 0.10               (2.11) 
 
x1 ≥ 0.042               (2.12) 
 
x2 ≥ 0.035               (2.13) 
 
x3 ≥ 0.042               (2.14) 
 
x4 ≥ 0.042               (2.15) 

 
สมการท่ี (2.12) ถึง (2.15) เปนขอจํากัดท่ีเก่ียวกับกระบวนการผลิต ในท่ีนี้กําหนดให

มีความสามารถในการผลิตไดไมนอยกวาคาเกรดความคลาดเคล่ือนสากล 10 หรือ IT 10 ทั้งหมด 
 

2.7 ขอจํากัดของโปรแกรมสําเร็จรูปทั่วไป 
โปรแกรมสําเร็จรูปสวนใหญออกแบบมาเพ่ือใชสําหรับการแกปญหาทั่วไป โดยไม

เฉพาะเจาะจงตองานใดงานหน่ึง เชน การหาผลลัพธที่เหมาะสมใหกับปญหาการแบงคาความ
คลาดเคลื่อน ดังน้ันการใชโปรแกรมสําเร็จรูปท่ัวไปจึงมีขอจํากัดคือ ผูใชตองทําการสรางสมการขึ้น
ใหมทุกครั้งท่ีมีการเปลี่ยนแปลงของคา IT No ดังตัวอยางในหัวขอ 2.6 จะพบวาในตอนเร่ิมตนได
กําหนดคา IT No ไวที่ IT 10 ทั้งหมด แตผลการคํานวณดวยโปรแกรมสําเร็จรูปทั่วไปไมสามารถ
คํานวณหาคําตอบได จึงตองมีการปรับเปล่ียนและกําหนดคา IT No เริ่มตนใหม ซึ่งอาจตองเสียเวลา
ทําการทดลองเปล่ียนคาใหมหลายครั้งกวาจะไดคําตอบท่ีดีที่สุด สงผลใหตองส้ินเปลืองเวลาในการ
ทํางานมากข้ึน ดังน้ันในงานวิจัยน้ีจึงไดพัฒนาโปรแกรมคอมพิวเตอรขึ้นใหม โดยรวบรวมขั้นตอน
การทํางานต้ังแตวิธีในการสรางกราฟตนไมไปจนถึงการคํานวณหาผลลัพธที่เหมาะสมที่สุดของ
ปญหาการแบงคาความคลาดเคล่ือนโดยใชวิธีซิมเพล็กซ  โปรแกรมสามารถปรับเปล่ียน
คา IT No ไดเองโดยอัตโนมัติและใหครอบคลุมไดมากท่ีสุด เพื่อลดขั้นตอนการทํางานท่ีไมจําเปน
และใหผูใชสามารถทํางานไดงายและมีความรวดเร็วย่ิงขึ้น 
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2.8 สรุป 
วิธีการวิเคราะหความคลาดเคล่ือนไดรับการพัฒนามาตลอด 50 ปที่ผานมา เพราะขนาดของ

ความคลาดเคล่ือนที่กําหนดใหกับมิติของชิ้นงานมีผลโดยตรงตอคาใชจายในการผลิต งานวิจัย
ทางดานวิศวกรรมความคลาดเคล่ือน (Tolerance Engineering) จึงเปนท่ีสนใจของนักวิจัยท้ังหลายท่ี
เก่ียวของกับการวางแผนกระบวนการ (process planning) การออกแบบผลิตภัณฑ (product design) 
การวัดละเอียด  (metrology) และการควบคุมคุณภาพ  (quality control) ยิ่ ง มีการประยุกตใช
คอมพิวเตอรดวยแลวจึงเปนแรงสงใหเกิดการขยายตัวของงานวิจัยทางดานการวิเคราะหความ
คลาดเคลื่อนอยางแพรหลาย กราฟตันไม (rooted-tree graph) เปนผลพวงจากวิวัฒนาการน้ันดวย ซึ่ง
เราสามารถนําเทคนิคของกราฟตนไมมาประยุกตใชกับการสรางความสัมพันธของความ
คลาดเคล่ือนจึงเปนวิธีที่สามารถทําไดงาย รวดเร็วและสามารถนําไปสรางเปนแบบจําลองทาง
คณิตศาสตร โดยใชความเชื่อมโยงของเสนทางท่ีแสดงความสัมพันธของมิติตาง ๆ เปนตัวสราง
สมการความสัมพันธของความคลาดเคล่ือน เพื่อใชในการคํานวณหาคาท่ีเหมาะสมดวยวิธีการ
โปรแกรมเชิงเสนตรง ซึ่งในงานวิจัยนี้จะไดใชเทคนิคที่กลาวมาขางตนเพื่อนําเสนอในรูปแบบของ
โปรแกรมคอมพิวเตอรสําเร็จรูป 



 

 

 

 

 

 

 

 

บทที่ 3 
โครงสรางโปรแกรม 

 

งานวิจัยนี้ไดนําเทคนิคของกราฟตนไมมาใช เปนหลักเกณฑในการสรางสมการ
ความสัมพันธของความคลาดเคล่ือนในรูปแบบของสมการเชิงเสนตรงเพ่ือคํานวณหาผลลัพธท่ี
เหมาะสมภายใตเง่ือนไขของคาความคลาดเคล่ือนมาตรฐานท่ีกําหนด มาพัฒนาเปนโปรแกรมช่ือ
วา “TOLOP” (Tolerance Optimization Program) โดยการพัฒนาโปรแกรมไดเลือกใชโปรแกรม    
ไมโครซอรฟวิชวลเบสิค 6 (Microsoft Visual Basic 6 หรือ VB 6) สําหรับเขียนคําส่ัง เน่ืองจากเปน
โปรแกรมที่สามารถสรางสวนติดตอกับผูใช (user interface) ไดอยางรวดเร็วและสามารถเรียนรู
วิธีการเขียนโปรแกรมไดดวยตนเอง  
 

3.1 องคประกอบของโปรแกรม TOLOP 
องคประกอบหลักของโปรแกรมสามารถแบงออกเปน  6 สวน  หรือ  6 โมดูล  ซ่ึงมี

ความสัมพันธเช่ือมโยงกันแสดงดังในรูปท่ี 3.1 

 

 
 

รูปท่ี 3.1 องคประกอบหลักของโปรแกรม TOLOP 
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3.1.1 โมดูลหลัก (main module) 
 โมดูลหลักมีหนา ท่ี เปนศูนยรวมสําหรับเ รียกใชงานในสวนตาง  ๆ  ของ

โปรแกรม โดยพื้นฐานแลวโมดูลหลัก จะเปนหนาจอหนาแรกท่ีปรากฏขึ้นหลังจากท่ีเขาสู
โปรแกรมคร้ังแรก (รูปท่ี 3.2) มีหนาจอที่ประกอบดวย ช่ือโปรแกรม ช่ือผูพัฒนาโปรแกรม 
นอกจากนั้นยังมีแถบเมนูและปุมคําส่ังตาง ๆ เหมือนกับหนาจอของโปรแกรมใชงานท่ัวไป มีไวให
ผูใชติดตอและส่ังงานโปรแกรม (รูปท่ี 3.3) ปุมคําส่ังเหลานี้ไดแก  
  - File สําหรับจัดการเกี่ยวกบัไฟล เชน เปดไฟล บันทึกขอมูล หรือ พิมพ 
   ขอมูล เปนตน 
  - Window สําหรับแสดงรายละเอียดหนาจอของโมดูลตาง ๆ ท่ีมีการทํางานอยู 
  ท้ังหมดไดแก หนาจอแสดงการปอนจํานวนมิติ (Input Dim) หนาจอแสดงการ 
  ปอนขอมูล (Input Data) หนาจอแสดงกราฟตนไม (Tree Graph) หนาจอแสดง 
  สมการเชิงเสน (Equation) หนาจอแสดงคําตอบท่ีเหมาะสมท้ังหมด (Feasible  
  Solution) และหนาจอแสดงคําตอบท่ีดีท่ีสุด (One Best Solution) 
 - Answer สําหรับแสดงคําตอบ สามารถแสดงไดท้ังคําตอบท่ีดีท่ีสุดซ่ึงมี 
  คา objective function มากท่ีสุด (One Best Solution) และคําตอบท่ีเหมาะสม 
  อ่ืน ๆ (Feasible Solution) ซ่ึงหมายถึงคําตอบท่ีผูใชสามารถเลือกมาใชงานได 
  ถึงแมจะไมใชคําตอบท่ีมีคาผลรวมของความคลาดเคล่ือนมากท่ีสุด แตก็เปน 
  คําตอบท่ีอยูในเง่ือนไขของเกรดความคลาดเคล่ือนมาตรฐานท่ีเรากําหนดให 
 - Run สําหรับเร่ิมตนใชงานโปรแกรมเพื่อเขาสูหนาจอสําหรับปอนจํานวนมิต ิ
 - Help เปนปุมท่ีมีไวเพื่อแนะนํารายละเอียดและวิธีการใชงานของโปรแกรม 
 สวนดานลางของหนาจอจะมีแถบสถานะ (status bar) เพื่อแสดงสถานะของไฟลท่ี
เก็บบันทึกขอมูลพรอมท้ังแสดงวันท่ีและเวลาขณะท่ีใชโปรแกรม  
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รูปท่ี 3.2 สวนประกอบของหนาจอเร่ิมตนหรือโมดูลหลัก 

 

 
 

รูปท่ี 3.3 สวนประกอบของแถบเมนู 
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หลังจากเขาสูโปรแกรมแลวการแกปญหาแตละครั้งจะเกิดข้ึนในโมดูลหลักซ่ึงครอบคลุม
การทําหนาท่ีของโมดูลอ่ืน ๆ โดยมีข้ันตอนท่ัวไปแสดงไดดังแผนภูมิรูปท่ี 3.4 เร่ิมจากการรับขอมูล
จากผูใชมาสรางกราฟตนไมเพื่อแสดงความสัมพันธระหวางมิติชุดเกาและมิติชุดใหม และสราง
ตารางคาความคลาดเคล่ือนมาตรฐาน จากนั้นนําความสัมพันธท่ีไดจากกราฟตนไมไปสรางเปน
สมการเชิงเสนตรงและดึงขอมูลคาความคลาดเคลื่อนมาตรฐานมาจากตารางขอมูล โดยหาคําตอบ
ของสมการไดจากโมดูลการคํานวณหาคาท่ีเหมาะสม (optimization module) การคํานวณในรอบ
แรกจะใชรูปแบบของเกรด IT No จํานวน 3,000 รูปแบบ เม่ือโปรแกรมทําการคํานวณครบ 3,000 
รูปแบบแลว จะทําการตรวจสอบวามีคําตอบหรือไม ถายังไมมีคําตอบจะเรียกใชโมดูลปรับปรุง
ความคลาดเคล่ือน (modification module) เพื่อปรับปรุงเง่ือนไขของคา IT No โดยอัตโนมัติ จากน้ัน
โปรแกรมจะกลับไปทําการคํานวณหาคําตอบในโมดูลการคํานวณหาคาท่ีเหมาะสมใหมจนกวาจะ
ไดคําตอบท่ีเหมาะสมตอไป 

 

 
 

รูปท่ี 3.4 ข้ันตอนการทํางานภายในโมดูลหลัก 
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3.1.2. โมดูลปอนขอมูล (Input module) 
 โมดูลปอนขอมูล มีหนาท่ีรับขอมูลตาง ๆ ท่ีผูใชปอนใหกับโปรแกรมและเก็บ

บันทึกไว ในฐานขอ มูล เพื่ อใชประมวลผล  เ ม่ือ ผู ใชกดปุม  Run จากหน าจอของโมดูล
หลัก หรือ เรียกใชคําส่ัง New ในแถบเมนู จะปรากฎหนาจอของโมดูลปอนขอมูลข้ึนมาดังรูป
ท่ี 3.5 ซ่ึงหนาจอจะประกอบดวย ชองวางหมายเลข 1 สําหรับใหผูใชปอนจํานวนมิติท่ีตองการลง
ไป หลังจากนั้นโมดูลปอนขอมูลจะสรางรูปแบบของการปอนขอมูลตามจํานวนมิติท่ีกําหนดดัง
แสดงในหมายเลข 2 สําหรับมิติจํานวน 4 มิติ ขอมูลท่ีตองทําการปอนใหกับโปรแกรม ไดแก 
ตัวอักษรท่ีใชแทนผิวช้ินงานของมิติท่ีเกิดจากการบอกขนาดในแบบและท่ีเกิดจากการกระบวนการ
ตัดโลหะ ขนาดมูลฐานของมิติเกา คาความคลาดเคล่ือนของมิติเกาและสําหรับการกําหนดคาความ
คลาดเคล่ือนมาตรฐานใหกับมิติใหมนั้นจะทําโดยการเลือกคาความคลาดเคล่ือนจากกระบวนการ 
(M/C Operation) ท่ีจะนําไปใชในการตัดมิตินั้น ๆ ของช้ินงาน เปนตน เม่ือผูใชทําการปอนขอมูล
จนครบแลวทําการบันทึกขอมูลโดยกดปุม  Save โปรแกรมจะทําการเก็บขอมูลเปนไฟล
นามสกุล .txt ในกรณีท่ีมีขอมูลเกาอยูในไฟลแลว และตองการนํามาประมวลผลก็สามารถเลือก
คําส่ังไดจากแถบเมนู File เลือกใชคําส่ัง Open จะปรากฏหนาตางดังรูปท่ี 3.6 เลือกไฟลท่ีตองการ
แลวกดปุม Open ขอมูลจะถูกนํามาใสไวท่ีหนาจอปอนขอมูล กลาวโดยสรุปการทํางานของโมดูล
ปอนขอมูลสามารถแสดงเปนข้ันตอนไดดังรูปท่ี 3.7 
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รูปท่ี 3.5 แสดงหนาจอปอนขอมูล 

 

 
 

รูปท่ี 3.6 แสดงหนาตาง Open  
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รูปท่ี 3.7 แสดงข้ันตอนการทํางานของโมดูลปอนขอมูล 
 

 3.1.3 โมดูลกราฟตนไม (tree graph module) 
 เปนสวนของการสรางกราฟตนไมของมิติชุดใหม โดยอาศัยเครื่องมือของไมโคร
ซอรฟวิชวลเบสิค 6 ท่ีเรียกวา คอนโทรลทรีวิว (control tree view) มีหนาท่ีในการแสดงผลขอมูล
ออกมาในลักษณะของโครงสรางตนไม (รูปท่ี 3.8) และใชกราฟท่ีสรางข้ึนนี้เพื่อหาเสนทางท่ีแสดง
ถึงความสัมพันธระหวางมิติชุดเกากับมิติชุดใหม จากน้ันนําเสนทางท่ีไดไปใชในการสรางสมการ
เชิงเสนตรงในโมดูลการคํานวณหาคาท่ีเหมาะสมตอไป 
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รูปท่ี 3.8 คอนโทรลทรีวิว  
 

3.1.4 โมดูลฐานขอมูลคาความคลาดเคล่ือนมาตรฐาน (International tolerance grades 
data base module) 
 โมดูลนี้แบงการทํางานเปน 2 สวนคือ สวนแรกจะเปนการสรางตารางฐานขอมูล
ของคาความคลาดเคล่ือนมาตรฐาน ISO 286-1 (IT No) โดยใชคอนโทรล MSHFlexGrid ซ่ึงเปน
เคร่ืองมือของไมโครซอรฟวิชวลเบสิค 6 มีหนาท่ีในการแสดงผลขอมูลใหอยูในรูปแบบของ
ตาราง ซ่ึงการแสดงขอมูลคาความคลาดเคล่ือนใหอยูในรูปแบบของตารางทําใหสะดวกตอการดึง
ขอมูลไปใชในการคํานวณ สําหรับสวนท่ีสองจะเปนการสรางรูปแบบของเกรด IT No 

3.1.5 โมดูลการคํานวณหาคาท่ีเหมาะสม (optimization module) 
 เปนโมดูลการประมวลผลเพ่ือหาคําตอบท่ีเหมาะสมดวยวิธีการโปรแกรมเชิง

เสนตรง มีหนาท่ีสรางสมการเชิงเสนตรงโดยอาศัยความสัมพันธจากโมดูลกราฟตนไมและดึงขอ
มูลคา IT No จากโมดูลฐานขอมูลของคาความคลาดเคล่ือนมาตรฐาน  มาสรางเปนสมการ
เร่ิมตน โดยโปรแกรมจะใชคอนโทรล MSHFlexGrid ในการดึงขอมูลตาง ๆ ใหอยูในรูปแบบของ
ตารางเพ่ือใหงายตอการคํานวณโดยใชวิธีตารางซิมเพล็กซ เม่ือทําการคํานวณในรอบแรกเสร็จ
โปรแกรมจะบันทึกผลลัพธท่ีได โดยจะบันทึกเฉพาะรอบที่สามารถหาคําตอบท่ีเหมาะสมได
เทานั้น จากน้ันทําการสับเปล่ียนรูปแบบของเกรด IT No ในรอบถัดไปจนครบ 3,000 รูปแบบ เม่ือ
โปรแกรมทําการคํานวณจนครบแลว ตรวจสอบวามีคําตอบหรือไม ถามีคําตอบใหนําคําตอบท่ีได
ท้ังหมดมาเปรียบเทียบวาคําตอบของเกรด IT No รูปแบบใดมีคาผลรวมของคาความคลาดเคล่ือนสูง
ท่ีสุดโดยจะเลือกคําตอบนั้นเปนคําตอบท่ีดีท่ีสุด ถายังไมมีคําตอบโปรแกรมจะเรียกใชโมดูล
ปรับปรุงความคลาดเคล่ือนเพื่อทําการสับเปล่ียนรูปแบบของเกรด IT No ตอไป 
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3.1.6 โมดูลปรับปรุงความคลาดเคล่ือน (modification module) 
 เปนโมดูลการปรับเปล่ียนคาความคลาดเคล่ือนแบบอัตโนมัติ โดยปรับเปลี่ยน

รูปแบบของเกรด IT No หลังจากท่ีโมดูลการคํานวณหาคาท่ีเหมาะสมทําการสับเปล่ียนรูปแบบของ
เกรด IT No มาแลว 3000 รูปแบบโดยจะทําหนาท่ีสงขอมูลรูปแบบของเกรด IT No กลับไปยัง
โมดูลการคํานวณหาคาท่ีเหมาะสมเพื่อทําการคํานวณในรอบถัดไป 
 

3.2 สรุป 
องคประกอบของโปรแกรม TOLOP มีท้ังหมด 6 สวน ในแตละสวนมีหนาท่ีและการ

ทํางานท่ีมีความเช่ือมโยงกัน โดยมีโมดูลหลัก ทําหนาท่ีเปนโปรแกรมหลักสําหรับเรียกใชงานใน
ทุกสวนของโปรแกรม โมดูลปอนขอมูล เปนสวนท่ีแสดงข้ึนมาเพื่อใหผูใชปอนขอมูลใหกับ
โปรแกรมสําหรับนําไปใชในการประมวลผลในสวนสําคัญอีก 4 สวนคือ โมดูลกราฟตนไม, โมดูล
ฐานขอมูลของคาความคลาดเคล่ือนมาตรฐาน, โมดูลการคํานวณหาคาท่ีเหมาะสม และ โมดูล
ปรับปรุงความคลาดเคลื่อน ซ่ึงจะไดอธิบายรายละเอียดเพิ่มเติมของข้ันตอนการทํางานท้ัง 4 สวนนี้
ในบทตอไป 

 



 

 

 

 

 

 

 

 

บทที่ 5 
สรุปผลการวิจัย 

 

5.1 สรุป 
งานวิจัยนี้สามารถบรรลุวัตถุประสงคท่ีตั้งไวคือ การพัฒนาโปรแกรมเพ่ือใชสําหรับแบงคา

ความคลาดเคล่ือนใหเหมาะสมกับมิติชุดใหมเม่ือระนาบอางอิงของการผลิตและการตรวจสอบ
แตกตางไปจากระนาบอางอิงของการบอกขนาดในแบบวิศวกรรม 

การใชเทคนิคกราฟตนไมทําใหงายตอการสรางความสัมพันธระหวางคาความคลาดเคล่ือน
ของมิติชุดใหมกับมิติชุดเกา โดยเทคนิคนี้ไมจําเปนตองอาศัยกฎเกณฑมากนัก เพียงแตสรางกราฟ
ของมิติชุดใหม ก็สามารถอานคามิติใชงานตาง ๆ ท่ีสัมพันธกับความตองการใชงานเดิมได
ทันที จากนั้นก็สามารถนํากราฟท่ีไดไปสรางสมการความสัมพันธสําหรับการหาคําตอบท่ีเหมาะสม
ดวยเทคนิคการโปรแกรมเชิงเสนตรง เทคนิคดังกลาวชวยทําใหเกิดความรวดเร็วในการกระจาย
ความคลาดเคลื่อน โดยเฉพาะอยางยิ่งในกรณีท่ีช้ินงานท่ีมีหลายมิติและมีกระบวนการขึ้นรูปท่ี
ซับซอน 
 โปรแกรมที่พัฒนาข้ึนไมเพียงหาผลลัพธท่ีเหมาะสมที่สุดใหกับปญหาการแบงคาความ
คลาดเคล่ือนไดเทานั้น แตยังสามารถหาผลลัพธท่ีเหมาะสมอ่ืน ๆ ท่ีมีคาความคลาดเคล่ือนอยูใน
เกณฑท่ีกําหนดไวพรอมกันดวย ซ่ึงทําใหผูใชสามารถเลือกใชไดมากกวา 1 คา โดยท่ีไมตองสราง
สมการเชิงเสนตรงดวยมือและปอนคาใหกับโปรแกรมใหมทุกคร้ังเม่ือมีการปรับเปล่ียน
คา IT No ทําใหชวยลดข้ันตอนและเวลาในการทํางานลงไดมาก ตลอดจนผูใชไมจําเปนตองมี
ความรูและความชํานาญในทางปฏิบัติมากนัก ก็สามารถกระจายความคลาดเคล่ือนใหกับมิติในการ
ผลิตหรือในการวัดขนาดใหมเพื่อคงไวซ่ึงความตองการใชงานของช้ินงานท่ีผูออกแบบกําหนดไว   

โปรแกรมนี้ยังมีสวนโตตอบกับผูใชเขาใจงาย อีกทั้งยังแสดงกราฟและขอมูลท่ีเปน
ประโยชนอยางครบถวน เหมาะสําหรับนักศึกษาหรือผูท่ีสนใจสามารถนํารหัสตนฉบับ (source 
code) ไปพัฒนาตอใหมีความยืดหยุนและครอบคลุมขอบเขตของงานใหมากข้ึนกวาเดิมได
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5.2 ขอจํากัดของโปรแกรม TOLOP 
 เนื่องจากโปรแกรมท่ีพัฒนาข้ึนนี้ใชสําหรับแบงคาความคลาดเคล่ือนใหกับมิติเชิงเสนตรง
ธรรมดาเทานั้น ซ่ึงไมสามารถนําไปใชในการวิเคราะหคาความคลาดเคล่ือนเชิงเรขาคณิต
ได นอกจากนั้นยังมีขอจํากัดอีกประการหนึ่ง คือ ขอจํากัดในเร่ืองของความเร็วในการประมวลผล
เมื่อช้ินงานรูปรางซับซอนและมีมิติจํานวนมาก   
 

5.3 ขอเสนอแนะในการพัฒนาตอไป 
 การพัฒนาโปรแกรมถือไดวาเปนไปตามวัตถุประสงค แตก็ยังมีหลายสวนท่ีสามารถนําไป
พัฒนาใหดีข้ึนได เชน ในกรณีท่ีช้ินงานมีมิติจํานวนมากโปรแกรมยังตองใชระยะเวลานานในการ
ประมวลผล ดังนั้นจึงควรปรับปรุงใหโปรแกรมมีความเร็วในการประมวลผลมากข้ึน ในสวนของ
การแสดงผลของกราฟควรปรับปรุงใหอยูในรูปแบบของกราฟฟกท่ีมีลักษณะใกลเคียงกับกราฟ
ตนไมมากข้ึน เพ่ือใหผูใชสามารถเขาใจไดงายข้ึนและการแสดงผลลัพธควรจะมีภาพกราฟฟกของ
ช้ินงานพรอมขนาดเพื่อใหเห็นรายละเอียดไดชัดเจนยิ่งข้ึน ดังนั้นโปรแกรมท่ีพัฒนาข้ึนนี้จึงเหมาะท่ี
จะเปนตนแบบเพื่อใหสามารถพัฒนาไปสูการนําไปใชในอุตสาหกรรมจริงตอไป 
 



 

 

 

 

 

 

 

 

รายการอางอิง 
 

Ahaluwalia, R. S. and Karolin, A. V. (1984). CATC A computer-aided tolerance control 
system. Journal of Manufacturing Systems. 3 (2) : 153-160. 

Drake, P. Jr., (1999). Dimensioning and tolerancing handbook. McGraw-Hill. 
Fainguelernt, D., Wiell, R., and Bourdet, P. (1986). Computer aided tolerancing and  

dimensioning in Process Planning, Annals of the CIRP. 35 (1): 381-386 
Farmer, L. E. and Harris, A. G. (1984). Change of datum of the dimensions on engineering 

Design drawings. International Journal of Machine Tool Design and Research. 
24 (4): 267-275. 

Gladman, C A. (1966). Manual for geometric analysis of engineering design. Australian Trade  
Publications. Sydney. 

Irani, S. A., Mittal, R. O., and Lehtihet, E. A. (1989) Tolerance chart optimization. International  
Journal of Production Research. 27 (9) : 1531-1552. 

Ji, P., (1993). A tree approach for Tolerance charting International Journal of Production 
Research. 31 (5) : 1023-1033. 

Liggett, J. V., (1993). Dimensional variations management handbook: A guide for  
quality design and manufacturing engineers. Prentice-Hall. 

Ngoi, B. K. A. (1992) Applying linear programming to tolerance chart balancing. International  
Journal of Advanced Manufacturing Technology. 7: 187-192. 

Ngoi, B. K. A., and Cheong, K. C. (1998). The apparent path tracing approach to tolerance  
charting. International Journal of Advanced Manufacturing Technology. 14:580-587 

Sermsuti-anuwat, Y., Whybrew, K., McCallion, H. (1995). CAPPFD – A tolerance-based  
feature sequencing CAPP system. Journal of Systems Engineering. 5 (1): 2-15. 

Sermsuti-anuwat, Y. (2009). Milling fixture design: a tolerance analysis approach.  
International Journal of Mechanical Engineering Education. 37 (2): 111-117.  

 
 
 
 



 

 

 

 

 

 

 

 

  

57 

Thimm, G., Britton, G. A., and Fok, S. C. (2004). A graph theoretic approach linking  
Design dimensioning and process planning. International Journal of Advanced  
Manufacturing Technology. 24: 261-271. 

Whybrew, K., Britton, G. A., Robinson, D. F., and Sermsuti-anuwat, Y. (1990). A graph- 
theoretic approach to tolerance charting. International Journal of Advanced  
Manufacturing Technology. 5: 175-183. 

Oyvind, Bjorke. (1978) Computer-aided tolerancing. Tapir Publishers. 



 

 

 

 

 

 

 

 

  

58 

 



 

 

 

 

 

 

 

 

 

ภาคผนวก ก 
 

ตารางเกณฑความคลาดเคลื่อนมาตรฐาน (ISO 286-2) 
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คูมือการใชงานโปรแกรม TOLOP 
 
 
 
 
 
 
 
 
 
  

 



 

 

 

 

 

 

 

 

  

คูมือการใชงานโปรแกรม 
TOLOP V.1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
พัฒนาโดย 

นางสาวอรวรรณ  นงนุช 
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คํานํา 
 

คูมือการใชงานโปรแกรมเลมน้ีจัดทําเพื่อเปนคูมือสําหรับชวยผูใชโปรแกรมในการเร่ิมตน
ใชงานโปรแกรม TOLOP ประกอบดวย 5 บท ไดแก บทที่ 1 แนะนําโปรแกรม บทท่ี2 การเร่ิมตน
ใชงานโปรแกรม บทท่ี3 วิธีการวิเคราะหความคลาดเคล่ือนดวยโปรแกรม TOLOP ซึ่งไดแสดง
ตัวอยางการวิเคราะหและออกแบบทีละขั้นตอนอยางละเอียด 

โปรแกรม TOLOP ขณะน้ี คือ รุนท่ี 1 ผูเขียนหวังวาคูมือการใชงานโปรแกรมฉบับน้ีจะ
ชวยใหผูอานสามารถใชงานโปรแกรม TOLOP ไดอยางเต็มประสิทธิภาพ หากมีขอเสนอแนะติชม
เพื่อการพัฒนาโปรแกรมตอไปสามารถติดตอผูเขียนไดโดยตรงตามท่ีแสดงไวในคูมือฉบับนี้ 

 
 

อรวรรณ  นงนุช 



 

 

 

 

 

 

 

 

  

บทที่1  
แนะนําโปรแกรม  

 

1.1 ระบบปฏิบัติการที่ตองการ 
1) ระบบปฏิบัติการ Windows 98 ขึ้นไป (แนะนํา Windows XP) 
2) เครื่องคอมพิวเตอรที่มี CPU ที่เปน Pentium 100 MHz ขึ้นไป 
3) หนวยความจํา 32 MB ขึ้นไป 
4) ไดรฟซีดีรอม (CD-ROM) สําหรับติดต้ังโปรแกรม 
5) การดแสดงผลที่สามารถแสดงผลที่ความละเอียดต้ังแต 800x600 ขึ้นไป (แนะนํา  

1024x768) 
6) เมาสและคียบอรดท่ีสนับสนุนการทํางานของวินโดวส 

 

1.2 ขั้นตอนการติดต้ังโปรแกรม 
1) เปดหนาตาง My Computer และเลือกไปยังโฟลเดอรที่เก็บไฟลไวและดับเบิลคลิกที่ไฟล  

Setup จะแสดงหนาตางดังรูปที่ M1.1 
2) ทําตามข้ันตอนท่ีแสดงในตัวติดต้ังโปรแกรมทีละขั้นตามลําดับ 

 

 
 

รูปที่ M1.1 หนาตางการติดต้ังโปรแกรม 
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1.3 การเขาสูโปรแกรม 
การเขาสูโปรแกรม TOLOP สามารถทําไดโดยไปที่ Window Start menu > Program > 

TOLOP ดังรูปที่ M1.2  

 

 
 

รูปที่ M1.2 



 

 

 

 

 

 

 

 

  

บทที่2  
การเริ่มตนใชงานโปรแกรม 

 

2.1 การเริ่มตนใชงานโปรแกรม TOLOP 
หลังจากเขาสูโปรแกรม TOLOP ตามขั้นตอนในหัวขอ 1.3 แลว โปรแกรมจะแสดงหนาจอ

เริ่มตนดังรูปท่ี M2.1 เชนเดียวกับโปรแกรมสวนใหญที่ทํางานภายใตระบบปฏิบัติการวินโดวส โดย
มีสวนประกอบของหนาจอดังตอไปน้ี 

1) แถบเมนู (Menu bar) มีไวใหผูใชติดตอและส่ังงานโปรแกรม  
2) ชื่อโปรแกรมและช่ือผูพัฒนาโปรแกรม 
3) แถบสถานะ (Status bar) สําหรับแสดงสถานะของไฟลที่เก็บบันทึกขอมูลพรอมท้ัง 

แสดงวันท่ีและเวลาขณะที่ใชโปรแกรม 

 

 
 

รูปที่ M2.1 สวนประกอบของหนาจอเร่ิมตน 
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2.2 แถบเมนู (Menu bar ) 
แถบเมนูที่แสดงอยูดานบนของหนาจอเปนคํา ส่ังท่ีมีไวใหผู ใชงานติดตอส่ังงาน

โปรแกรม ซึ่งมีสวนประกอบดังรูปที่ M2.2 

 

 
รูปที่ M2.2 สวนประกอบของแถบเมนู 

 

คําอธิบายเพิ่มเติมสําหรับแถบเมนู 
File>New    สรางงานใหม 
File>Open    เปดงานเกา 
File>Save As    บันทึกงานในช่ือใหม 
File>Print    พิมพรายงาน 
File>Exit    ออกจากโปรแกรม 
 
Window>Input Dim   หนาตางแสดงหนาตางปอนขอมูลจํานวนมิติ 
Window>Input Data   หนาตางแสดงหนาตางปอนขอมูล 
Window>Tree Graph Expand  หนาตางสําหรับแสดงการขยายขนาดของกราฟตนไม 
Window>Equation   หนาตางแสดงสมการเร่ิมตน 
Window> Feasible Solution  หนาตางแสดงคําตอบที่เหมาะสม 
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Answer>One Best Solution  แสดงคําตอบที่ดีทีสุ่ด 
Answer>Feasible Solution  แสดงคําตอบที่เหมาะสม 
 
Run     เริ่มตนการทํางานของโปรแกรม 
Help>How To Use   วิธีใชงานโปรแกรม 
 

2.3 การปอนขอมูล (Input Data) 
เม่ือผูใชกดท่ีแถบเมนู Run (รูปที่ M2.3) โปรแกรมจะแสดงหนาตางสําหรับปอนขอมูล (รูป

ที่ M2.4) ในชองหมายเลข 1 ใหปอนจํานวนมิติที่ตองการ โดยจํานวนมิติที่ปอนจะตองมีจํานวน
ตั้งแต  3 มิ ติขึ้นไป  เ ม่ือปอนตัวเลขจํานวนมิติแลวใหกดท่ีปุม  OK หรือ  กดท่ีปุม  Enter บน
คียบอรด จากน้ันโปรแกรมจะแสดงหนาจอสําหรับปอนรายละเอียดของขอมูลในกรอบหมายเลข 2   

 

 
 

รูปที่ M2.4 หนาตางสําหรับปอนขอมูล 
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รูปที่ M2.4 หนาตางสําหรับปอนขอมูล 
 

การปอนขอมูลผูใชจะตองปอนขอมูลใหครบทุกชอง โดยรายละอียดของขอมูลท่ีตองปอน
ใหกับโปรแกรมมีดังนี้ (รูปที่ M2.5) 

1) ปอนตัวอักษรที่ระบุผิวเริ่มตนของมิติเกาในชองขอความ From  
2) ปอนตัวอักษรที่ระบุผิวปลายของมิติเกาในชองขอความ To 
3) ปอนขนาดมูลฐานของมิติเกาในชองขอความ Basic Dim 
4) ปอนคาความคลาดเคล่ือนของมิติเกาลงในชองขอความ (+/-)1/2 Tol 
5) ปอนตัวอักษรที่ระบุผิวเริ่มตนของมิติใหมในชองขอความ From  
6) ปอนตัวอักษรที่ระบุผิวปลายของมิติใหมในชองขอความ To 
7) ปอนขอมูลกระบวนการผลิตโดยคลิกเลือกที่ลูกศรในชองขอความ M/C Operation 
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รูปที่ M2.5 การปอนขอมูลใหกับโปรแกรม 

 
การปอนขอมูลใหกับโปรแกรมจะตองปอนเฉพาะขอมูลที่ เปนตัวอักษรใหกับชอง

หมายเลข 1, 2, 5 และ 6 เทานั้น ถาผูใชปอนขอมูลที่เปนตัวเลข เคร่ืองหมาย หรือ สัญลักษณอื่นใด
โปรแกรมจะแสดงกลองขอความดังรูปที่ M2.6 (a) การปอนขอมูลใหกับชองหมายเลข 3 จะตอง
ปอนเฉพาะขอมูลท่ีเปนตัวเลขเทาน้ัน ถาผูใชปอนขอมูลท่ีเปนตัวอักษร เครื่องหมาย หรือ 
สัญลักษณอื่นใด โปรแกรมจะแสดงกลองขอความดังรูปที่ M2.6 (b) และการปอนขอมูลใหกับชอง
หมายเลข 4 จะตองปอนเฉพาะขอมูลท่ีเปนตัวเลขเทาน้ัน ถาผูใชปอนขอมูลที่ เปนตัวอักษร 
เครื่องหมาย หรือ สัญลักษณอื่นใด โปรแกรมจะแสดงกลองขอความดังรูปที่ M2.6 (c) 

 

 
 

รูปที่ M2.6  



 

 

 

 

 

 

 

 

 
 

 

 
70 

2.4 การบันทึกขอมูล (Save Data) 
หลังจากท่ีผูใชปอนขอมูลเสร็จเรียบรอยแลว ผูใชสามารถทําการการบันทึกขอมูลไวใน

หนวยความจําไดโดยมีขั้นตอนการบันทึกดังนี้ 
1) คลิกที่คําส่ัง File > SaveAs บนแถบเมนู หรือคลิกที่ปุม SAVE จะมีหนาตาง Save As  

แสดงข้ึนมาดังรูปที่ M2.7 
2) เลือกโฟลเดอรที่ตองการบันทึกขอมูล 
3) ปอนชื่อไฟลที่ตองการบันทึกขอมูลลงในชอง File name 
4) คลิกที่ปุม Save ขอมูลจะถูกบันทึกเปนไฟลนามสกุล .txt เชน 4 dimension.txt  

 

 
รูปที่ M2.7 หนาตางบันทึกขอมูล 
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2.5 การเริ่มงานใหม (New) 
เม่ือตองการเร่ิมแผนงานใหมใหไปที่คําส่ังบนแถบเมนู คลิกที่ File > New รูปที่ M2.8

จากน้ันโปรแกรมจะแสดงหนาจอใหใสจํานวนมิติใหม ดังรูปที่ M2.9 

 

 
 

รูปที่ M2.8 

 

 
 

รูปที่ M2.9 
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2.6 การเปดขอมูล (Open data) 
การเปดขอมูล คือ การนําขอมูลที่บันทึกไวในหนวยความจํามาใสลงในชองวางของหนาจอ

ปอนขอมูลโดยมีขั้นตอนดังนี้ 
1) คลิกที่ File > Open บนแถบเมนูจะมีหนาตาง Open แสดงข้ึนมาดังรูปที่ M2.10 
2) ไปยังโฟลเดอรที่เก็บไฟลขอมูลไว 
3) เลือกไฟลขอมูลที่ตองการ 
4) คลิกที่ปุม Open ขอมูลจะถูกปอนลงในชองวาง (ขอมูลที่สามารถเปดไดตองมีนามสกุล 

เปน .txt) จากน้ันขอมูลก็จะถูกนําไปใสไวในชองวางของหนาจอปอนขอมูล ดังรูป 
ที่ M2.11 

 

 
 

รูปที่ M2.10 หนาตางคําส่ังเปดไฟลขอมูล 

 

 
 

รูปที่ M2.11 
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2.7 การหาผลลัพธ 
 เม่ือใสขอมูลและบันทึกขอมูลเรียบรอยแลวข้ันตอไปจะเปนการหาผลลัพธ โดยกดที่ปุม 
SOLVE โปรแกรมจะแสดงกลองขอความถามวาตองการ RUN เกรด IT No จากนอยไปมาก
หรือไม” ดังรูปท่ี  M2.12 ถาตองการใหโปรแกรมรันคา  IT No จากคานอยไปคามากใหกด
ปุม Yes โปรแกรมจะทําการประมวลผลโดยเริ่มคํานวณจากคา IT No นอยที่สุดกอน แตถาตองการ
ใหโปรแกรมประมวลผลจาก IT No มากไปนอย ใหกดปุม No โปรแกรมก็จะทําการคํานวณจาก
คา IT No มากท่ีสุดกอน  

 

 
 

รูปที่ M2.12 
 

ในกรณีที่จํานวนรูปแบบของ IT No ไมถึง 3000 รูปแบบ โปรแกรมจะทําการประมวลผล
โดยสามารถหาคําตอบไดในคราวเดียว ถาพบคําตอบโปรแกรมจะแสดงกลองขอความดังรูป
ที่ M 2.13 (a) แตถาไมมีคําตอบโปรแกรมจะแสดงกลองขอความดังรูปที่ 2.13 (b) 

 

 
 

รูปที่ M2.13 
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สําหรับกรณีที่มีจํานวนรูปแบบมากกวา 3000 รูปแบบ โปรแกรมจะทําการประมวลผลใน
รอบแรกโดยใช IT No จํานวน 3000 รูปแบบกอน เม่ือทําการประมวลผลครบ 3000 รูปแบบแลว ถา
พบคําตอบโปรแกรมจะแสดงกลองขอความ  ดังรูป ท่ี  M2.14 (a) แตถ าประมวลผลครบ 
3000 รูปแบบแลวยังไมพบคําตอบ โปรแกรมจะแสดงกลองขอความ ดังรูปที่ M2.14 (b) 

 

 
 

รูปที่ M2.14 
 

2.7.1 หนาจอแสดงผลลพัธ 
 หนาจอแสดงผลลัพธสามารถเลือกใหแสดงผลได 2 หนาจอ ดังนี้ 
 1) หนาจอแสดงคําตอบที่ดีที่สุด ซึ่งเปนคําตอบที่มีผลรวมของคาความ 

คลาดเคลื่อนมากที่สุดแสดงดังรูปที่ M2.15 สามารถบันทึกคําตอบโดยกด 
ปุม Save และพิมพคําตอบโดยกดปุม Print 

 

 
 

รูปที่ M2.15 หนาจอแสดงคาํตอบที่ดีทีสุ่ด 
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 2) หนาจอแสดงคําตอบที่เหมาะสม ซึ่งเปนคําตอบที่สามารถนําไปเลือกใชไดแต 
ไมใชคําตอบที่มีผลรวมของคาความคลาดเคล่ือนมากที่สุด แสดงดังรูป 
ที่ M2.16 สามารถบันทึกคําตอบโดยกดปุม Save และพิมพคําตอบโดยกด 
ปุม Print 

 

 
 

รูปที่ M2.16 หนาจอแสดงคาํตอบที่เหมาะสม 
 

2.7.2 หนาจอแสดงกราฟตนไม  
 หนาจอนี้จะแสดงกราฟตนไมที่สรางขึ้นจากความสัมพันธของมิติใหมโดยมี
ลักษณะดังรูปที่ M2.17 

 

 
 

รูปที่ M2.17 หนาจอแสดงกราฟตนไม 
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2.8 การพิมพรายงาน (Print) 
การส่ังพิมพขอมูลจะตองทําการบันทึกขอมูลลงไฟลกอนทุกครั้ง ไมเชนน้ันโปรแกรมจะ

ไมสามารถส่ังพิมพขอมูลได เม่ือเลือกคําส่ัง Print แลว โปรแกรมจะแสดงหนาตาง Print ดังรูปที่ 
M2.17 ซึ่งการส่ังพิมพขอมูลสามารถส่ังพิมพไดจากคําส่ังที่อยูในแถบเมนู ตาง ๆ ดังนี้  

1) คลิกที่คําส่ัง File > Print > Form main เพื่อพิมพขอมูลของหนาตางหลัก 
2) คลิกที่คําส่ัง File > Print > Equation เพื่อพิมพสมการ 
3) คลิกที่คําส่ัง File > Print > One Best Solution เพื่อพิมพคําตอบที่ดีที่สุด 
4) คลิกที่คําส่ัง File > Print > Feasible Solution เพื่อพิมพคําตอบที่เหมาะสมทั้งหมดที่ 

สามารถนํามาเลือกใชได 

 

 
 

รูปที่ M2.17 หนาตางคําส่ังพิมพ 
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2.9 การออกจากโปรแกรม (Exit program) 
เม่ือตองการออกจากโปรแกรมใหคลิกที่ Files > Exit หรือคลิกที่เคร่ืองหมาย × ที่ดานขวา

บนสุดของหนาตางหลัก ดังรูปที่ M2.18 

 

 
 

รูปที่ M2.18 



 

 

 

 

 

 

 

 

  

บทที่ 3 
วิธีการวิเคราะหความคลาดเคลื่อนดวยโปรแกรม TOLOP 

 
เนื้อหาในบทน้ีจะเปนการนําตัวอยางโจทยมาสาธิตการใชงานโปรแกรม TOLOP แบบเปน

ขั้นตอนเพ่ือใหเขาใจวิธีการใชงานของโปรแกรม TOLOP ยิ่งขึ้น 
 

ตัวอยางท่ี 1  
โจทยตัวอยางน้ีมีมิติของช้ินงานจํานวน 4 มิติ (รูปท่ี M3.1) ซึ่งระบุขนาดความคลาดเคล่ือน

ของมิติความยาวเปนคาเบี่ยงเบนเทา ๆ กัน โดยกําหนดให (Y1 ± y1) ถึง (Y4 ± y4) เปนมิติชุดเกา 
และ (X1 ± x1) ถึง (X4 ± x4) เปนมิติชุดใหมที่ตองการทราบคา การใชโปรแกรมเพื่อหาคาความ
คลาดเคลื่อนชุดใหม มีขั้นตอนดังนี้  

 

 
  

รูปที่ M3.1 ตัวอยางชิ้นงาน 4 มิติ 
 

1) ปอนจํานวนมิติเทากับ 4 ลงในชอง Input Number of dimensions ดังรูปที่ M3.2 จากน้ัน 
กดปุม OK หรือกดปุม Enter ที่คียบอรด  

2) โปรแกรมจะแสดงหนาจอสําหรับปอนขอมูลจํานวน 4 แถว จากน้ันใหปอนขอมูลลงใน 
ชองวางใหครบทุกชอง ดังรูปที่ M3.3 
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3) กดปุม SAVE เพื่อทําการบันทึกขอมูล 
4) กดปุม SOLVE เพื่อหาผลลัพธ 
5) เม่ือโปรแกรมประมวลผลเสร็จแลวจะแสดงผลลัพธ ดังรูปที่ M3.4  

 

 
 

รูปที่ M3.2 

 

 

 
 

รูปที่ M3.3 
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รูปที่ M3.4 

 
คําตอบท่ีดีที่สุดของโจทยตัวอยางนี้ คือ คําตอบที่มีคาผลรวมของคาความคลาดเคล่ือนมาก

ที่สุด เทากับ 0.1465 ซึ่งอยูในขอบเขตของความคลาดเคล่ือนมาตรฐานท่ีมากท่ีสุด โดยมีคา
ความคลาดเคล่ือนที่ไดดังนี้ 

คาความคลาดเคลื่อนของมิติ ±x1 = ±0.0665 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x2 = ±0.0135 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x3 = ±0.0245 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x4 = ±0.0420 เลือกใชเกรดความคลาดเคล่ือน IT 10 
นอกจากคําตอบท่ีดีที่สุดแลวยังสามารถเลือกใชคําตอบอ่ืน ๆ ในหนาจอของ Feasible 

Solution ได อี กด วย  และยั งสามารถ เ ลือกดู ข อ มูล อ่ืน  ๆ  ที่ ได จ ากการประมวลผลของ
โปรแกรม เชน หนาจอแสดงกราฟตนไม (รูปท่ี M3.5) และหนาจอแสดงสมการเร่ิมตน (รูป
ที่ M3.6) 
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รูปที่ M3.5 

 

 
 

รูปที่ M3.6 
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ตัวอยางท่ี 2  
โจทยตัวอยางน้ีมีมิติของช้ินงานจํานวน 6 มิติ (รูปท่ี M3.7) ซึ่งระบุขนาดความคลาดเคล่ือน

ของมิติความยาวเปนคาเบี่ยงเบนเทา ๆ กัน โดยกําหนดให (Y1 ± y1) ถึง (Y6 ± y6) เปนมิติชุดเกา 
และ (X1 ± x1) ถึง (X6 ± x6) เปนมิติชุดใหมที่ตองการทราบคา การใชโปรแกรมเพื่อหาคาความ
คลาดเคลื่อนชุดใหม มีขั้นตอนดังนี้ 

1) ปอนจํานวนมิติเทากับ 6 ลงในชอง Input Number of dimensions แลวกดปุม OK หรือ 
กดปุม Enter ที่คียบอรด  

2) โปรแกรมจะแสดงหนาตางสําหรับปอนขอมูลจํานวน 6 แถว จากน้ันทําการปอนขอมูล 
ลงในชองวางใหครบทุกชอง ดังรูปที่ M3.9 

3) กดปุม SAVE เพื่อทําการบันทึกขอมูล 
4) กดปุม SOLVE เพื่อหาผลลัพธ 
5) เม่ือโปรแกรมประมวลผลเสร็จแลวจะแสดงผลลัพธดังรูปที่ M3.10 

 

 
 

รูปที่ M3.7 ตัวอยางชิ้นงาน 6 มิติ 
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รูปที่ M3.8 

  

 
 

รูปที่ M3.9 
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รูปที่ M3.10 

 
คําตอบท่ีดีที่สุดของโจทยตัวอยางนี้ คือ คําตอบที่มีคาผลรวมของคาความคลาดเคล่ือนมาก

ที่สุด เทากับ 0.4335 ซึ่งอยูในขอบเขตของความคลาดเคล่ือนมาตรฐานท่ีมากท่ีสุด โดยมีคา
ความคลาดเคล่ือนที่ไดดังนี้ 

คาความคลาดเคลื่อนของมิติ ±x1 = ±0.1165 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x2 = ±0.0335 เลือกใชเกรดความคลาดเคล่ือน IT 9 
คาความคลาดเคลื่อนของมิติ ±x3 = ±0.0165 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x4 = ±0.1670 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x5 = ±0.0500 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x6 = ±0.0500 เลือกใชเกรดความคลาดเคล่ือน IT 10 
นอกจากคําตอบท่ีดีที่สุดแลวยังสามารถเลือกใชคําตอบอ่ืน ๆ ในหนาจอของ Feasible 

Solution ได อี กด วย  และยั งสามารถ เ ลือกดู ข อ มูล อ่ืน  ๆ  ที่ ได จ ากการประมวลผลของ
โปรแกรม เชน หนาจอแสดงกราฟตนไม (รูปที่ M3.11) และหนาจอแสดงสมการเริ่มตน (รูป
ที่ M3.12) 
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รูปที่ M3.11 

 

 
 

รูปที่ M3.12 
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ตัวอยางท่ี 3 
โจทยตัวอย าง น้ีมีมิ ติของชิ้นงานจํานวน  8 มิ ติ  (รูปที่  M3.13) ซึ่ งระบุขนาดความ

คลาดเค ล่ือนของมิ ติความยาว เปนค า เบี่ ยง เบนเท า  ๆ  กัน  โดยกํ าหนดให  (Y1 ± y1) ถึ ง 
(Y8 ± y8) เปนมิติชุดเกา และ (X1 ± x1) ถึง (X8 ± x8) เปนมิติชุดใหมที่ตองการทราบคา ขั้นตอน
การใชโปรแกรมเพื่อหาคาความคลาดเคล่ือนชุดใหม มีขั้นตอนดังนี้  

1) ปอนจํานวนมิติเทากับ 8 ลงในชอง Input Number of dimensions จากน้ันกด 
ปุม OK หรือกดปุม Enter ที่คียบอรด โปรแกรมจะแสดงหนาตางสําหรับปอนขอมูล 
จํานวน 8 แถว เชนเดียวกับทั้งสองตัวอยางที่กลาวมาขางตน จากน้ันปอนขอมูลลงใน 
ชองวางใหครบทุกชอง ดังรูปที่ M3.14 

 

 
 

รูปที่ M3.13 ตัวอยางชิ้นงาน 8 มิติ (Farmer and Harris, 1984) 
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รูปที่ M3.14 
 
3) กดปุม SAVE เพื่อทําการบันทึกขอมูล 
4) เม่ือกดปุม SOLVE เพื่อหาผลลัพธ การประมวลผลของโปรแกรมในตัวอยางนี้จะมีความ 

แตกตางจากตัวอยางทั้ง 2 ตัวอยางขางตน เนื่องจากรูปแบบของเกรด IT No ของตัวอยาง 
นี้มีมากกวา 3,000 รูปแบบ โดยจะมีจํานวนรูปแบบอยูทั้งหมด 6,561 รูปแบบ ซึ่งมา 
จาก เกรด IT No ที่ใชในแตละมิติ คือ 3 เกรด ซึ่งมีมิติทั้งหมด 8 มิติ ดังนั้นจึงมีรูปแบบ 
ของเกรด IT No ทั้งหมดที่ตองใชในการคํานวณ คือ 3^8 นั่นเอง เม่ือโปรแกรมทําการ 
ประมวลผลโดยใชรูปแบบของเกรด IT No ครบ 3,000 รูปแบบแลวจะแสดงหนาจอดัง 
รูปที่ M3.15 ซึ่งในตัวอยางนี้สามารถหาผลลัพธไดแลว แตอาจจะยังไมใชคําตอบที่ดีที 
สุด ถาตองการท่ีจะใหโปรแกรมทําการประมวลผลตอใหกดปุม Yes โปรแกรมจะแสดง 
กลองขอความใหใสจํานวนรูปแบบที่ตองการใหทําตอ ในตัวอยางนี้เราจะใหโปรแกรม 
ทําตอไปอีก 3,561 รูปแบบ ดังรูปที่ M3.16 

5) เม่ือโปรแกรมประมวลผลเสร็จแลวจะแสดงผลลัพธ ดังรูปที่ M3.17 คําตอบที่ดทีี่สุดของ 
โจทยตัวอยางนี้ คือ คําตอบที่มีคาผลรวมของคาความคลาดเคล่ือนมากท่ีสุด เทากับ  
0.3835 ซึ่งอยูในขอบเขตของความคลาดเคล่ือนมาตรฐานท่ีมากท่ีสุด โดยมีคา 
ความคลาดเคล่ือนที่ไดดังนี้ 

คาความคลาดเคลื่อนของมิติ ±x1 = ±0.1000 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x2 = ±0.0485 เลือกใชเกรดความคลาดเคล่ือน IT 9 
คาความคลาดเคลื่อนของมิติ ±x3 = ±0.0300 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x4 = ±0.0350 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x5 = ±0.0780 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x6 = ± 0.0420 เลือกใชเกรดความคลาดเคล่ือน IT 10 
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คาความคลาดเคลื่อนของมิติ ±x7 = ± 0.0335 เลือกใชความคลาดเคล่ือนมาตรฐาน IT 10 
คาความคลาดเคลื่อนของมิติ ±x8 = ± 0.0165 เลือกใชความคลาดเคล่ือนมาตรฐาน IT 8 

 

 
 

รูปที่ M3.15 

 

 
 

รูปที่ M3.16 
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รูปที่ M3.17 
 

นอกจากคําตอบท่ีดีที่สุดแลวยังสามารถเลือกใชคําตอบอ่ืน ๆ ในหนาจอของ Feasible 
Solution ได อี กด วย  และยั งสามารถ เ ลือกดู ข อ มูล อ่ืน  ๆ  ที่ ได จ ากการประมวลผลของ
โปรแกรม เชน หนาจอแสดงกราฟตนไม (รูปที่ M3.18) และหนาจอแสดงสมการเริ่มตน (รูป
ที่ M3.19) 

 

 
 

รูปที่ M3.18 
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รูปที่ M3.19 
 



 

 

 

 

 

 

 

 

 

ภาคผนวก ค 
 

รายการโปรแกรม (Program Listings) 
 
 
 
 
 
 
 
 
 

 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

ภาคผนวก ง 
 

บทความวิชาการที่ไดรับการตีพิมพเผยแพร 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

 

 

บทความวิชาการที่ไดรับการตีพิมพเผยแพร 
 

อรวรรณ  นงนุช และ ยงยุทธ  เสริมสุธีอนุวัฒน (2552). เทคนิคการกระจายคาความคลาด
เคลื่อนท่ีเหมาะสมเมื่อเดตัมของการบอกขนาดเปลี่ยนแปลง. การประชุมวิชาการขายงานวิศวกรรม
อุตสาหการ, 21 – 22 ตุลาคม 2552, มหาวิทยาลัยขอนแกน, ประเทศไทย. 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

ประวัติผูเขียน 
 
 นางสาวอรวรรณ  นงนุช เกิดเม่ือวันที่ 5 ตุลาคม พ.ศ. 2526 ภูมิลําเนาอยูที่บานเลขท่ี 
35/388 หมู 6 ตําบลเขาสามยอด อําเภอเมืองลพบุรี จังหวัดลพบุรี เร่ิมเขาศึกษาระดับประถมศึกษาท่ี
โรงเรียนวรพิทยา ระดับมัธยมตนที่โรงเรียนวินิตศึกษาในพระราชูปถัมภฯ ระดับมัธยมปลายท่ี
โรงเรียนพระนารายณ และเร่ิมเขาศึกษาระดับปริญญาตรีที่ สาขาวิชาวิศวกรรมโลหการ สํานักวิชา
วิศวกรรมศาสตร มหาวิทยาลัยเทคโนโลยีสุรนารี จังหวัดนครราชสีมา เม่ือป พ.ศ. 2545 และสําเร็จ
การศึกษาเม่ือป พ.ศ. 2548 หลังจากสําเร็จการศึกษาไดเขาทํางานกับ บริษัท สหวิริยาเพลทมิล
จํากัด จังหวัดชลบุรี เปนเวลา 1 ป  
 จากนั้นไดเขาศึกษาตอในสาขาวิชาวิศวกรรมอุตสาหการ สํานักวิชาวิศวกรรมศาสตร 
มหาวิทยาลัยเทคโนโลยีสุรนารี ในป พ.ศ. 2550 ในขณะที่ศึกษาตอในระดับปริญญาโท ไดเปน
ผูชวยสอนรายวิชาปฏิบัติการกรรมวิธีการผลิต ของสาขาวิชาวิศวกรรมอุตสาหการ 
 ผลงานวิจัย : ไดเสนอบทความเขารวมในการประชุมวิชาการขายวิศวกรรมอุตสาหการ 
ประจําป 2552 เรื่องเทคนิคการกระจายคาความคลาดเคล่ือนที่เหมาะสมเม่ือเดตัมของการบอกขนาด
เปล่ียนแปลง 
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